Getting Started with Galaxy Explorer
Version 5.5

Galaxy Explorer

Nielsen
Media Research
Nielsen Media Research is a registered trademark of Nielsen Media Research, Inc. N Design and Nielsen is a trademark or registered trademark of CZT/ACN Trademarks, L.L.C. Microsoft, Windows, ActiveX, Visual Basic, and Windows NT are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. PowerBuilder is a registered trademark of Powersoft Corporation. JavaScript is a registered trademark of Sun Microsystems Inc. Other product names mentioned herein may be trademarks or registered trademarks of their respective owners.

This documentation contains proprietary information of Nielsen Media Research. Publication, disclosure, copying, or distribution of this document or any of its contents is prohibited, unless consent has been obtained from Nielsen Media Research.

The following products are trademarks or registered trademarks of the companies indicated:

- DynaZIP Inner Media, Inc.
- Galaxy Nielsen Media Research, Inc.
- NEWT NetManage, Inc.
- SQL Anywhere Sybase, Inc.

Copyright © 2006 Nielsen Media Research, Inc. All rights reserved.

Printed in the U.S.A.
## Contents

**Notes to Readers**

### Chapter 1  Introducing Galaxy Explorer
- About Galaxy Explorer ................................................................. 1-2
- What You Need to Run Galaxy Explorer ........................................... 1-4
- Logging in to and Exiting Galaxy Explorer ....................................... 1-5
- The Galaxy Explorer Main Window ................................................ 1-6
- Understanding the Window Components ........................................ 1-7
- Performing Common Procedures .................................................... 1-8
- Using Online Help ........................................................................... 1-10
  - Accessing Help ........................................................................... 1-11
  - Finding Different Kinds of Information ......................................... 1-12

### Chapter 2  Defining Criteria Groups
- An Overview of Criteria Groups ...................................................... 2-2
- Creating Daypart Groups ............................................................... 2-3
- Creating Demographic Groups ....................................................... 2-5
- Creating Originator Groups ............................................................ 2-6
- Creating Program Names Groups ................................................... 2-7
- Creating Statistic Groups ............................................................... 2-8
- Creating Type Code Groups ........................................................... 2-9
- Creating Viewing Source Groups .................................................. 2-10

### Chapter 3  Requesting Overnight Reports
- What is Overnights? ....................................................................... 3-2
- Requesting an Overnight Report .................................................... 3-3
  - Selecting Averaging and Sorting Options ................................. 3-5
  - Requesting Program Data ......................................................... 3-7
  - Requesting Timeperiod Data .................................................... 3-9
- Scheduling Overnight Requests ...................................................... 3-10

### Chapter 4  Requesting Ranking/Tracking Reports
- What is Ranking/Tracking? ........................................................... 4-2
- Requesting a Ranking/Tracking Report .......................................... 4-3
  - Defining a Report Measurement Period ........................................ 4-4
  - Selecting a Season Year Reporting Measurement Period ............ 4-5
Chapter 5  Working with Explorer Reports

An Overview of Reports ................................................................. 5-2
Viewing Report Status ................................................................. 5-3
Downloading Reports ................................................................. 5-4
Viewing and Printing Reports ..................................................... 5-5

Chapter 6  Working with Lightning Requests

What is Lightning? ........................................................................... 6-2
Grid Report .................................................................................... 6-3
Program Report ............................................................................ 6-4
Ranking Report ............................................................................. 6-6
TimePeriod Report ......................................................................... 6-7
Trending Report ............................................................................ 6-8
Creating a Lightning Request ......................................................... 6-9
Using the Lightning Wizard .......................................................... 6-10
Selecting Demographics ............................................................. 6-12
Selecting Statistics ......................................................................... 6-13
Selecting Measurement Periods ..................................................... 6-14
Selecting Dayparts ......................................................................... 6-16
Selecting Originator Information .................................................. 6-17
Selecting Program Types and Inclusions ....................................... 6-18
Selecting Program Names ............................................................ 6-19
Selecting Program Details ........................................................... 6-20
Designating Ranking Information ................................................ 6-21
Selecting Coverage Area/Viewing Sources ................................. 6-22
Opening an Existing Lightning Request ....................................... 6-23
Changing the Criteria or Viewing Level of a Lightning Report ... 6-24
Saving Lightning Reports in Excel ................................................ 6-26
Deleting an Existing Lightning Request ....................................... 6-27

Chapter 7  Managing Your Software

Changing Your Password ............................................................. 7-2
Chapter 8  Additional Features

Exporting Groups and Requests ................................................................. 8-2
Importing Groups and Requests ............................................................. 8-3
Attaching a Macro ................................................................................. 8-4
Setting Preferences ............................................................................... 8-5

Glossary

Index
Notes to Readers

*Getting Started with Galaxy Explorer* introduces you to the 5.1 version of Galaxy Explorer. In this guide, you will learn the basics of how to get in and out of Galaxy Explorer; how to build and submit report requests; and how to download, print, and view the results.

**Finding Information**

The Galaxy Explorer online Help provides detailed information about using the system. You access the Help from within Galaxy Explorer. The *Galaxy Explorer Reference Guide* provides quick access to some of Nielsen Media Research’s standard reporting criteria and standard templates.

**About This Guide**

This guide supplements the Help and contains the following chapters:

- **Chapter 1, “Introducing Galaxy Explorer,”** introduces the system and its basic concepts, as well as how to use the online Help.
- **Chapter 2, “Defining Criteria Groups,”** explains how to create the different groups you use as criteria when building a report request.
- **Chapter 3, “Requesting Overnight Reports,”** describes how to build Overnight report requests and submit them for processing.
- **Chapter 4, “Requesting Ranking/Tracking Reports,”** describes how to build Ranking/Tracking report requests and submit them for processing.
- **Chapter 5, “Working with Explorer Reports,”** discusses how to view the processing status of your report requests, download the report data, and view and print the final reports.
- **Chapter 6, “Working with Lightning Requests,”** describes how to build Lightning report requests, display Lightning reports, and change the criteria and viewing level of Lightning reports.
- **Chapter 7, “Managing Your Software,”** explains how to update your Galaxy Explorer software, change your password, view general announcements, and view information on reprocessed data.
- **Chapter 8, “Additional Features,”** provides instructions on how to use some of the advanced features available in Galaxy Explorer.

The glossary in the back of the book defines the terms used throughout this guide.

**Galaxy Explorer Support**

Nielsen Media Research is dedicated to providing the best possible customer service. If you have questions, you can call the Client Support Services Helpline at 1-800-423-4511.
This chapter provides basic instructions for getting up and running with Galaxy Explorer. The following topics are covered:

- About Galaxy Explorer
- What You Need to Run Galaxy Explorer
- Logging in to and Exiting Galaxy Explorer
- The Galaxy Explorer Main Window
- Understanding the Window Components
- Performing Common Procedures
- Using Online Help
  - Accessing Help
  - Finding Different Kinds of Information
About Galaxy Explorer

Galaxy Explorer lets you create custom reports based on Nielsen Media Research National and Hispanic audience estimates. This application is part of the Nielsen Media Research Galaxy suite of products.

What is Galaxy Explorer?

Galaxy Explorer is a Windows®-based application that lets you produce a variety of reports based on Nielsen Media Research National and Hispanic audience estimates. There are currently three different reporting products available as a part of Galaxy Explorer:

- **Overnights** lets you generate reports for a single day or week of ratings data for broadcast, syndication, and cable originators. Reports can include any or all of the available viewing types: Live, Live Plus Same Day (Live+SD), and Live Plus Seven Days (Live+7) through Explorer's side by side reporting options.
- **Ranking/Tracking** lets you generate reports for a user-defined period of ratings data for multiple originators and media types. Reports can include any or all of the available viewing types: Live, Live Plus Same Day (Live+SD), Live Plus Seven Days (Live+7), as well as the Most Current (MC) report option through Explorer's side-by-side reporting options.
- **Lightning** lets you generate online, interactive summary-level reports for season, monthly, and quarterly data. While audience estimates are initially reported as Live, Live estimates are replaced by Live+7 estimates as they become available. You can change the criteria or viewing level of the report and receive online responses. Custom measurement periods are also available.

What Can You Do with Galaxy Explorer?

Using Galaxy Explorer, you can:

- Analyze timeperiod, viewing source and usage, and program data
- Categorize data by timeperiod and by program
- Report timeperiod data for individual days, averages, or both
- Report program data using a variety of averaging options
- Report program averages and/or individual telecast data, as well as cable trackage and episode averages
- Report live and time-shifted data and compare the percent difference between viewing types
- Create reports using predefined templates or create your own custom templates
- Produce reports that you can view and format in Microsoft® Excel

How Do You Use Galaxy Explorer to Create Explorer Reports/Data Flow?

Galaxy Explorer provides you with a complete set of options for creating the reports you need. First, you define the report content and structure by building a report request. Then you submit the request to the server for processing. When processing is complete, you can download the report data to your PC and view or print the completed report.

The following illustration shows the report request process:
How Do You Use Galaxy Explorer to Create Lightning Reports?

Galaxy Lightning provides you with a set of wizards to create and work with report data interactively. You select your report options using wizard windows. When you click Finish, the report automatically displays on your PC monitor. You can work with the data by changing the viewable data or you can change the report criteria.

An illustration of this process is shown below.

What Types of Data Can You Report?

Galaxy Explorer delivers live and time-shifted viewing data by reporting the following:

- **Live** = Households tuning or Persons viewing a program or time period of a specific station or cable network, including VCR record, at the actual time the show was telecast. Any use of the DVR to time shift content (regardless of how small the delay) will cause that tuning to be excluded from the Live estimates.

- **Live+SD** = Households tuning or Persons viewing a program or time period of a specific station or cable network, including VCR record, at the actual time the show was telecast, and any DVR playback tuning/viewing in the same processing day to a pre-recorded program or time period that is shifted 'back' to original telecast time. The processing day is the same collection day used for daily processing; however, this will also include some households that are in different time zones than the market with which they are collected. As a result, data for some homes may be collected at 2:00 a.m. instead of 3:00 a.m. local time.

- **Live+7** = Households tuning or Persons viewing a program or time period of a specific station or cable network, including VCR record, at the actual time the show was telecast, and any DVR playback tuning/viewing within 7 days (168 hours) to a pre-recorded program or time period that is shifted 'back' to original telecast time.

- **Most Current (MC)** = The latest data available, crossing viewing types, if necessary, based on the measurement interval selected. For example, selecting Most Current data for a measurement interval that is incomplete for Live+7 results in an average of the Live+7 and Live+SD data that is available to date. When the data requested includes measurement periods prior to TSV implementation (December 26, 2005), Most Current will include a combination of Live (pre-TSV) data, Live+7, and Live+SD available to date.
What You Need to Run Galaxy Explorer

To achieve the best performance when using Galaxy Explorer, your PC should meet the minimum requirements listed below.

Minimum Hardware Requirements

- 256 megabytes RAM
- 131 megabytes available hard disk space for the following files:
  - 50 megabytes for Galaxy Explorer software plus PB runtime libraries and DynaZIP™, etc.
  - 20 megabytes for Microsoft Excel
  - 5 megabytes for NEWT™
  - 50 megabytes for user-generated reports
  - 1 megabyte for FlexFmtr
  - 5 megabytes for the nmr folder (Sybase related files)
- 56K external business class modem or digital connection
- SVGA monitor
- Windows 2000/NT/XP

Software Provided by Nielsen Media Research

- Sybase PC Net Library™ and Open Client™ Library version 11.1.1
- RedBrick™ 32 ODBC Driver
- PowerBuilder™ 9.0 Runtime Libraries
- Adaptive Server SQL Anywhere (ASA) 9.0
- DynaZIP version 3.00.17 (Taken from the properties dialog)
- DynaZIP Wrapper 2.1
- Nccomm 2.5
- Microsoft Excel 97 or 2000
- Galaxy Explorer software
Logging in to and Exiting Galaxy Explorer

Starting the system takes you to the Galaxy Explorer main window. From this window, you can access any of the main functions within Galaxy Explorer.

To log in to the system:

1. Click the Start button, point to Programs, and then click Galaxy Explorer.
2. Enter your user ID and press Tab.
   
   Tip Using the Preferences window, you can set up your user ID to default so you don’t have to retype it each time you log in. For details, see “Setting Preferences” on page 8-5.
3. Enter your password and click OK. The login window closes and you can select one of the available Galaxy Explorer products.

To exit the system:

- From the File menu, select Exit Galaxy Explorer. The Galaxy Explorer main window closes, and you return to Windows.
The Galaxy Explorer Main Window

The Galaxy Explorer main window provides access to the primary functions within the system.

The Galaxy Explorer main window is the first window you see upon entering the system. This window is the starting point from which you access all available functions.

The main window includes the display area and the frame. The display area holds the individual Galaxy Explorer windows. The frame includes the title bar, menu bar, and toolbars. Detailed descriptions of the individual toolbar buttons are provided in the online Help.

**Tip**  To show or hide the toolbars or change their location, select Toolbars from the Window menu.

The different parts of the main window are described below.

- **Control Menu Box**
  Click to display menu options for controlling the window's appearance.

- **Navigation Toolbar**
  Click a button to open the associated window.

- **Menu Bar**
  Click a menu title to open the menu. Click option to select it.

- **Display Area**
  Displays the open Galaxy Explorer windows.

- **Status Bar**
  Displays prompts for using the system and system processing messages.

- **Function Toolbar**
  Click a button to execute the associated function.

**Note** The function toolbar displays once you select the Overnights, Ranking/Tracking, or Lightning toolbar button.
Understanding the Window Components

Working in Galaxy Explorer is very similar to other Windows-based applications.

Because Galaxy Explorer is a Windows application, it uses standard graphical objects or components. You communicate with the system by clicking or selecting these objects with your mouse.

This section describes the components that are common to most Galaxy Explorer windows, such as text boxes, drop-down lists, and command buttons. When a component appears gray or dimmed, it means that option is currently not available for selection. The following illustration identifies the different window components and how to use them.
Performing Common Procedures

You should be comfortable performing the following common procedures.

Many of these actions require you to first select Overnights, Ranking/Tracking, or Lightning from the Products menu. Once you open a product, the Function toolbar becomes available.

Opening an Item

To modify, remove, or export an item you must first open it.

To open an item:

1. Click the Open button on the toolbar.
   -or-
   From the File menu, select Open.
2. Select a request, group, or schedule and click Open.
   Tip You can also open an item by double-clicking it.

Saving an Item

If you modify an item you must save it to make sure your changes are not lost.

To save an item:

• Click the Save button on the toolbar.
  -or-
  From the File menu, click Save. The system saves the request, group, or schedule with the name you defined when you built it.

To save a Lightning report as an Excel file:

1. From the File menu, select Save As.
2. From the Save as type drop-down list, select the .xls extension and enter the name you want to assign this file in the File name field.
3. If desired, change the location where the file is to be stored.
4. Click OK.

Copying an Item

Copying saves you time when you want to create an item that is similar to one that already exists.

To copy an item:

1. Open the request, group, or schedule you want to copy.
2. Click the Copy button on the toolbar.
   -or-
   From the File menu, select Copy. The system clears the name box.
3. Enter a new name.
4. Make any desired changes and click the Save button on the toolbar. The system saves the modified request, group, or schedule under the new name.
Removing an Item

Removing an item permanently removes it from your PC. You cannot remove items that are currently in use, for example, a group that is included on a current request.

*Note* You cannot use the Remove option to remove individual components within a group. To remove parts of a group, use the Edit menu.

**To remove an item:**

1. Open the request, group, or schedule you want to remove.
2. Click the **Remove** button on the toolbar.
   - or -
   From the **File** menu, select **Remove**.

Closing an Item

You can close an item by closing the window. If you modified the item and did not save, the system will prompt you to save your changes.

**To close a window:**

- Click the **Close** button on the toolbar.
  - or -
  From the **File** menu, select **Close**.

Displaying Pop-up Menus

On many of the Galaxy Explorer windows you can display a pop-up menu that includes options specific to where you are on the window.

**To display a pop-up menu:**

1. Position your mouse in the area of the window where you are currently working and press the right mouse button. The pop-up menu appears.
2. Click the option you want.

Using Drag and Drop

The drag and drop feature lets you arrange the order of items within a list box. You can also use this feature to move items from an Available list box to a Selected list box.

**To use drag and drop:**

1. Select the items you want to move.
   
   *Tip* You can select multiple contiguous items by clicking the first item and holding down Shift as you click the last item. You can select multiple non-contiguous items by clicking the first item and holding down Ctrl as you click each additional item.

2. Holding down the mouse button, drag the items to the new location and release the mouse button.
Using Online Help

The online Help for Galaxy Explorer provides information about the system, such as procedures, window descriptions, terminology, and basic concepts.

Help is designed so you can go directly from the application to a specific topic or navigate through a series of related topics. Topics are linked to other related topics, so you can “jump” from one topic to another by clicking on colored words and phrases or by using the Help button bar.

The different parts of the Help window are described below.
Using Online Help

Accessing Help

There are three ways to access a Help topic: from the Help Contents window, from an application window, and from the Search for Help window.

Viewing the Help Contents

The Help Contents, similar to a table of contents, shows the types of information in the Help system.

To view the Help Contents:

- From the application Help menu, select Contents.
- Or-
  - From within the Help system, click the Contents button.

Getting Help for the Current Window

The Help system includes topics specific to each Galaxy Explorer window. These are referred to as context-sensitive topics because they are specific to the context in which you are using the system. A context-sensitive topic provides a description of the current window and usually includes a graphical image of the window. You can click on parts of the window to display detailed information.

To get Help for the current window:

- Click the Help button on the toolbar.
- Or-
  - Click the Help button on the current window.
  - Or-
    - Press the F1 key.
  - Or-
    - From the application Help menu, select Context.

Searching for a Topic

Using the Search for Help window, you can find a topic by typing a word or its beginning letters and instructing the system to list any related topics.

To search for a topic:

- From the application Help menu, select Search for Help on.
- Or-
  - From within the Help system, click the Search button.

Note: The Search for Help window provides instructions on how to complete a topic search.
Using Online Help

Finding Different Kinds of Information

Using the Help buttons, you can navigate through the Help system to find the information you need.

Once you access a topic in the Help system, you can use the buttons just above the topic title to access various types of related topics. These buttons change based on the type of topic you are currently viewing. For example, if you are viewing a window description topic, there is a button for related procedures and, possibly, navigation.

When you click a button, a pop-up window appears with a list of jumps to related topics. If there is only one related topic, clicking a button usually takes you directly to the related topic.

<table>
<thead>
<tr>
<th>For Help on...</th>
<th>Click:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concepts - descriptive information about the data entered at a particular application window</td>
<td>Concepts</td>
</tr>
<tr>
<td>Related Concepts or Procedures - descriptive information or step-by-step instructions for related tasks or other windows</td>
<td>Related Concepts or Procedures</td>
</tr>
<tr>
<td>Window - description of an application window and its parts</td>
<td>Window</td>
</tr>
<tr>
<td>Terminology - list of terms for which you can see definitions</td>
<td>Terminology</td>
</tr>
</tbody>
</table>
Chapter 2
Defining Criteria Groups

This chapter explains how to create the different groups you use as criteria when building a report request. The following topics are covered:

- An Overview of Criteria Groups
- Creating Daypart Groups
- Creating Demographic Groups
- Creating Originator Groups
- Creating Program Names Groups
- Creating Statistic Groups
- Creating Type Code Groups
- Creating Viewing Source Groups
An Overview of Criteria Groups

You can create criteria groups prior to building your report requests or at the same time.

To make building requests more flexible, Galaxy Explorer lets you create criteria groups that you store separately from your requests. As you build a request, you simply select the criteria groups you want to use.

This feature provides several benefits:

- You can use the same group across multiple requests.
- You can modify a group once, and the changes are automatically applied to any requests using that group.
- You can share your groups with other users using the import and export features.

Many of the groups you build can also be used across samples. This means you can use the same groups whether you are building a request based on the National People Meter (NPM) sample or the National Hispanic People Meter (NHPM) sample. There are some exceptions, however. The following items must be created separately for each sample:

- Originator groups
- Viewing source groups
- Type code groups
Creating Daypart Groups

A daypart is an interval of time within a day for which you can report audience data. It is defined by days and hours. You can use daypart groups to define a list of dayparts you want to use in the program or timeperiod section of a report.

To create a daypart group:

1. Click the Dayparts button on the toolbar. The Dayparts window appears.
2. In the Group Name box, enter a name for the group and press Tab.
3. To select your own timeperiod, select the days of the week you want to include and how you want to average the data as shown below and proceed to step 5.
   -or-
   To choose a daypart that uses the pre-assigned daypart codes for programs, select an option from the Standard Dayparts drop-down list. Then continue with step 4.
4. If you use a standard daypart, you cannot select timeperiods. Also, if you use a standard daypart and it has combined dayparts, the Combined Dayparts text boxes automatically populate.
5. In the Time area, enter the start and end time for the daypart. Use the format: hh:mmxx, where hh = hour, mm = minutes, and xx = a.m. or p.m.
   - For a.m. hours, you can type just the number; for example, you would type 8 for 8 a.m.
   - For p.m. hours, type the number and pm; for example, you would type 8pm for 8 p.m. You do not need to use capitalization or punctuation.
   - For all hours, you can use the military time; for example, you would type 20 for 8 p.m.
   Note If you want to create a daypart with a start and end time that crosses the standard 6 a.m.-to-6 a.m. day or combine non-contiguous days and times into a single daypart, you must create a combined daypart.
6. Select one or more report segments for calculation in this daypart. The completed daypart entry appears in the list box.
7. To add another daypart to the group, right-click, select Add Row and return to step 3.
8. The dayparts are reported in the order they appear in the list box. To arrange the order, use the drag and drop feature.

9. To save the group, click the Save button on the toolbar.

For More Information
For more information, search for “combined dayparts” and “daypart groups” in the online Help.
Creating Demographic Groups

Demographics are the classification of sample members based on age, sex, or households.

By defining different demographic groups, you can have your ratings data on a report calculated for a particular category or categories of the viewing audience.

You cannot use the same demographic groups with both the National and Hispanic sample; you must create them separately. Before building a group, open the Sample menu to make sure you are currently using the sample for which you want to create that group.

To create a demographic group:

1. Click the Demographics button on the toolbar. The Demographics window appears.
2. In the Group Name box, enter a name for the group and press Tab.
3. Select an audience category and age range for the demographic.
   
   Note  The Households category does not have an associated start and end age.

4. To add another demographic, right-click, select Add Row and repeat step 3.
5. To save the group, click the Save button on the toolbar.

   Note  On the Groups tab, you can access the Demographics window by right-clicking on the Statistics field. You can right-click to create a new group or view and edit existing group details.

For More Information

For more information, search for “demographic groups” in the online Help.
Creating Originator Groups

You cannot use the same originator groups with both the National and Hispanic sample; you must create them separately.

An originator is any entity responsible for originating programs. When requesting a program report, you select an originator group to identify whose programs you want to see.

To create an originator group:

1. Click the **Originators** button on the toolbar.
2. In the **Group Name** box, enter a name for the group and press Tab.
3. Select the originators you want to include in the group.

   - **Note**: If you include an originator in a combo, you can select that same originator more than once. To see an originator individually, as well as a contributor to a combo, select the originator again and do not use a combo code the second time.

4. To save the group, click the **Save** button on the toolbar.

   - **Note**: On the Groups tab, you can access the Originators window by right-clicking on the Statistics field. You can right-click to create a new group or view and edit existing group details.

For More Information

For more information, search for “originator groups” in the online Help.
Creating Program Names Groups

You can create program names groups using the Program Names window, or you can perform a program search and save the results as a names group.

When requesting a program report, you select a program names group to identify specific programs, episodes, and/or trackages you want to include in your report.

To create a program names group:

1. Click the Names button on the toolbar.
2. In the Group Name box, enter a name for the group and press Tab.
3. Right-click and select Add Row.
4. Enter a complete or partial program name, episode name, and/or trackage name.

   **Tip** Typing * in front of a string of characters includes in the group all names that contain that character string. Typing * after a string of characters includes in the group all names that start with that character string.

5. To add the next program to the group, right-click, select Add Row and repeat step 4.
6. To save the group, click the Save button on the toolbar.

For More Information

For more information, search for “program names groups” in the online Help.
Creating Statistic Groups

For every request you build, you must select a statistic group.

Statistics are the various types of audience estimates you can include in a Galaxy Explorer report, such as coverage area average audience rating (CVG AA%). When creating statistic groups, you can choose from all available viewing types: Live, Live+SD, Live+7, as well as the Most Current (MC) report option. Once selected, you can report and/or rank them by households, demographics, or both. If a time-shifted viewing type (Live+SD or Live+7) is selected, you can compare the percent difference between the selected viewing types by selecting one of the %DIFF statistics. The Most Current report option is not currently compared to any other viewing type using a %DIFF statistic.

Note You can select only one statistic to rank by households and only one to rank by demographics.

To create a statistics group:

1. Click the Statistics button on the toolbar.
2. In the Group Name box, enter a name for the group and press Tab.
3. Select a statistic and how you want it reported.
   Tip You can select the same statistic more than once, using different precisions.
4. To add another statistic, right-click, select Add Row and repeat step 3.
5. The statistics are reported in the order they appear in the list box. To arrange the order, use the drag and drop feature.
6. To save the group, click the Save button on the toolbar.

Note On the Groups tab, you can access the Statistics window by right-clicking on the Statistics field. You can right-click to create a new group or view and edit existing group details.
Creating Type Code Groups

You can use type code groups as program search criteria or reporting criteria. To use proprietary type codes, you must select an originator group for which you are the owning originator.

Type codes are program genres that you can use to select the types of programs you want to include on a report. Summary type codes are groupings of similar detail type codes and can be used when requesting broadcast, syndication, or cable programs. Detail type codes are more specific genres and can be used when requesting cable programs only.

Note  Detail type codes do not belong to more than one summary type code.

To create a type code group:

1. Click the **Type Code** button on the toolbar.
2. In the **Group Name** box, enter a name for the group and press **Tab**.
3. From the **Type Code Category** drop-down list, select the set of type codes you want to display in the **Available** list box.
4. Select the type codes you want to include in the group.
5. The type codes are reported in the order they appear in the list box. To arrange the order, use the drag and drop feature.
6. To save the group, click the **Save** button on the toolbar.

For More Information
For more information, search for “type code groups” in the online Help.
Creating Viewing Source Groups

You cannot use the same viewing source groups with both the National and Hispanic sample; you must create them separately.

Viewing sources consist of one or more categories of viewing within a certain coverage area, for which you want to report timeperiod or daypart data. The data can be based on the coverage area Total U.S. or a specific cable originator’s coverage area. For example, if your request includes viewing source group XYZ affiliates within the coverage area Total U.S., and a timeperiod group of 8:00 - 9:00 p.m., your report will include viewing to all XYZ affiliates in the total U.S. between the hours of 8:00 and 9:00 p.m.

To create a viewing source group:

1. Click the Viewing Source button on the toolbar.
2. In the Group Name box, enter a name for the group and press Tab.
3. From the Coverage Area drop-down list, select a coverage area.
4. Select the viewing sources you want to include in the group.
   
   **Tip** You can include viewing sources from different coverage areas in the same group.

   Select the viewing sources you want to include and click Add>>.

   
   The viewing sources are reported in the order they appear here. To arrange the order, drag and drop them within the list box.

   
   To combine two or more viewing sources into a group, enter a single letter in the Combo Code box.

   Then enter a description in the Combo Description box. This description prints on your report.

   
   **Note** If you include a viewing source in a combo, you can select that same viewing source more than once. To see a viewing source individually as well as a contributor to a combo, select the viewing source again and do not use a combo code the second time.

5. To save the group, click the Save button on the toolbar.

For More Information

For more information, search for “viewing source groups” in the online Help.
Chapter 3
Requesting Overnight Reports

This chapter explains the basics of how to build an Overnight report request. The following topics are covered:

- What is Overnights?
- Requesting an Overnight Report
  - Selecting Averaging and Sorting Options
  - Requesting Program Data
  - Requesting Timeperiod Data
- Scheduling Overnight Requests
What is Overnights?

The Overnights product lets you generate reports based on the most current data.

The Overnights product lets you generate reports based on current available data for broadcast and cable originators, as well as weekly data for syndication originators. You can create reports using the National People Meter or National Hispanic People Meter samples, but you cannot combine them. You can, however, combine data from different media types within a single report. The Overnights product also gives you the option of creating reports that include program data, timeperiod data, or a combination of both. The requests you create can be used over and over again to report the same type of data but for different dates or originators.

Newly created or existing Overnights can include any or all of the available viewing types: Live, Live Plus Same Day (Live+SD), and Live Plus Seven Days (Live+7) through Explorer's side-by-side reporting options. Side by side reporting allows you to report any two or all three viewing types in vertical columns, aligned side by side, in order to perform comparisons of time-shifted viewing data. The %DIFF statistics can also be included in Overnights for additional viewing type comparisons. The %DIFF statistics are straight calculations that compare the differences between viewing types based on Household or Demographic Total U.S. AA (000), regardless of the statistics requested within the report specification. These new statistics have been added to the statistics selection screen and can be selected like any other statistic when creating a statistic group. For details, see “Creating Statistic Groups” on page 2-8.

You can request an Overnight report for a specific day, or week, of current or historical viewing data. Once you create a request, it must be submitted to the server and processed for the specific dates you select. When the processing is complete, you can download the data to your PC and view or print the final report.

You can automate this process by building a schedule of requests that are applied to the most current data on a regular basis. This type of request is referred to as an auto Overnights request.
Requesting an Overnight Report

The Overnights product lets you generate reports for a day or week of audience data for broadcast, syndication, or cable originators.

You can use a template to create your Overnights reports or you can design your own. The Overnights product comes with templates for building a variety of program and timeperiod reports, as well as reports that include combined program and timeperiod information.

To request an Overnights report:

1. Click the Overnights button on the toolbar.
2. Assign the request a name and enter the title you want to appear at the top of your report.
3. From the Template Name drop-down list, select the template you want to use and answer Yes to the message that appears. The format settings for the template you selected appear on the Format tab.
   
   Tip To see how the report will look, select Preview Report . . . from the Request menu.
4. On the Groups tab, select the demographics and statistics groups you want to use and the program and/or timeperiod information you want to include.
   
   Tip The required items, based on the template you selected, appear in bold.

Select the demographic group you want to report on. Select the statistic group you want to see on the report.

If requesting a program report, complete this section. See “Requesting Program Data” on page 7.

If requesting a timeperiod report, complete this section. See “Requesting Timeperiod Data” on page 9.

If requesting a combined program and timeperiod report, complete both sections.

Note If you select an originator or viewing source group that includes items for which you do not have unlimited access, these items are not included in your final report.

5. To save the request, click the Save button on the toolbar.
6. To submit the request for processing, click the Submit button on the toolbar. The Submit window appears so you can select the dates for which you want to generate reports.

Note If you want to wait and submit your requests when it is more convenient to connect to the server, or submit multiple requests at once, click the Hold for Submission button on the toolbar.
Requesting an Overnight Report...

7. To report on individual days, click the **Daily** tab.
   -or-
   To report on weeks, click the **Weekly** tab.
   **Note**  Daily data is not available for syndication.

8. Select the specific dates for which you want to generate a report.

   Select the type of calendar you want to use for selecting your dates.
   Click the dates for which you want to generate reports. Click again to remove a date.
   Select a month to change the displayed monthly calendars.

   **Note**  Dates that appear in black boxes are Nielsen Media Research nonreporting weeks.
   These dates are available for reporting.

9. When you complete your selections, click **OK**.
   **Note**  At this point, you can use the Submitted Status tab on the Report Manager window to track the processing status of your requests. For details, see “Viewing Report Status” on page 5-3.

For More Information

For more information on completing the Overnights Request window, search for “Overnights requests” in the online Help. For more information on custom templates and designing your own reports, search for “custom templates.”
Selecting Averaging and Sorting Options

Use the Avg Opts tab on the Overnights request window to select averaging and sorting options.

When requesting program data, the 1/4 hour Levels to Include options are not available with the Strict Daypart and Daypart Over-runs reporting options.

To select averaging and sorting options:

1. From the request window, click the Avg Opts tab.
2. In the Additional Averaging Options area, indicate if you want to average program data across like days; for example, average across all Mondays.
   
   Note This averaging option is dictated through the daypart group for timeperiod reporting.

3. In the Levels to Include area, indicate at what levels you want to report data and the report segments you want to display for each.
   
   Note If you make no selections, the report automatically displays total program averages. Any other selections you make must also be selected on the Format tab.

4. To display the programs in alphabetical order, from the Sort area, select Alphabetical.
   -or-
   To display the programs by telecast in order of the date and time they aired, select Chronological.

5. To include breakouts or specials in your program averages, in the Combine with Pgm Avg area, select the appropriate check box.
   
   Note Averaging will only occur if the breakouts and specials have the same program identification as the related program.

6. If desired, select additional reporting options.

Select to report repeats separately from the rest of your program data.

Select to start season-to-date averaging again at a premiere.

Select to report separately the viewing of segments of programs that start before and/or end after the daypart.

Select to substitute episode names for any program names of movies or sports.

Note This option only applies to cable programs.

Select to include contributing viewing of all programs that air within the daypart, regardless of their start and end times.
7. To have a bottom line average on your Microsoft Excel report for originators, viewing sources, dayparts, summary type codes, detail type codes, or measurement periods, select the appropriate check box.

8. To include a combined report total for each selected bottom line average report option(s), select the Report Totals check box.

9. If you use a grid template, depending on the template, one or more of the Grids options are automatically selected. You can also select one or more of the following.

    Select to include the bottom line average for the originator based on entire programs.
    Select to include viewing source data for half-hour intervals.

    Select to include viewing source data for quarter-hour intervals.
    Select to include the bottom line average for the originator based on strict dayparts.

**Note**  Up to four hours of data for six networks fit on one printable grid page.
Requesting an Overnight Report

Requesting Program Data

Use the Program section to identify the programs you want to appear on your report.

The system uses the selections you make in the Program section of the request to build a program list for the report. In addition to these selections, you can select program indicators, type code groups, and/or program names groups to further define the programs you want to appear on your report.

When requesting program data, note the following rules:

- If you want to request proprietary information, you must select an originator group of which all the members are owned by your originator.
- If originators or dayparts are included in the format section of your request, then the groups you select also appear as elements on your report.
- When requesting a combination of timeperiod and program information, you must select the same daypart group in both the Program and Timeperiod sections.
- Selecting a daypart group limits the programs reported to those with start times that fall within the dayparts included in the daypart group.
- You cannot view the program list prior to submitting the request, because the request does not have a date associated with it yet. The system uses the date(s) you select at submission time to generate the program list at the same time it processes the request.

To request program data:

1. From the **Overnights** window, click on the **Groups** tab.
2. From the **Originators** drop-down list, select the originator group whose programs you want to report on.
3. To report on a specific portion of a day, select a daypart group from the **Dayparts** drop-down list.
4. To include programs based on certain program indicators, click the **Indicators** tab.

Checkmarks identify the services for which each indicator is available.

To exclude programs based on the indicator, select this check box.

For some indicators you can enter a specific value. For example, you can enter 30 for Normal Duration to see programs with a normal duration of 30 minutes.

Select an indicator and click **Add>>**. You can also add an item by double-clicking on it.

To add several items click on the first item and, while holding down Shift, click on the last item. Then click **Add>>**.
5. To include programs based on certain type codes, click the **Type Codes** tab.  
   
   **Note** When you exclude a type code group, all other type code groups of the same category are also excluded.

6. To include a specific program names group, click the **Names** tab.
Requesting an Overnight Report

Requesting Timeperiod Data

Use the Timeperiod section to select the viewing source groups and daypart groups you want to appear on your report.

When completing the Timeperiod section, note the following rules:

• When requesting timeperiod information only, you must select a viewing source group and a daypart group. Both viewing sources and dayparts must appear on the Format tab.
• When requesting a combination of timeperiod and program information, you must select the same daypart group in both the Program and Timeperiod sections.

To request timeperiod data:

1. From the Overnights window, click on the Groups tab.
2. From the Viewing Sources drop-down list, select the viewing source group that represents the coverage area and viewing source combinations for which you want to report data.
3. From the Dayparts drop-down list, select the daypart group that identifies what portion of the day you want to report on.
Scheduling Overnight Requests

Galaxy Explorer begins processing your scheduled Overnight requests as soon as the data is available for the frequency you selected.

You can automate the process of submitting your Overnight requests by putting them on the Overnight schedule. Once the requests are processed, you can locate them on the Report Manager window and download them to your PC.

**Note** You can only schedule the Three Section Overnight Report as an auto overnight.

**To schedule Overnight requests:**

1. Click the **Scheduler** button on the toolbar.
2. Click the **Overnights** tab.
3. Right-click and select **Add Row**.
4. Select the request you want to schedule for processing.
5. Repeat steps 3 and 4 for each request you want to include on the schedule.
6. Click the **Save** button on the toolbar.
7. To place the scheduled request on the server, click the **Activate Schedule** button on the toolbar.
   **Note** To monitor the processing of your scheduled requests, use the Submitted Status tab on the Report Manager window. From this tab, select Auto Overnights or Grid Auto Overnights from the **Type** list.
8. To temporarily remove the scheduled request from the server, click the **Deactivate Schedule** button on the toolbar.
   **Note** To modify a row on the schedule, you must first deactivate it. When you have completed your changes, you can make it active again by selecting the row and clicking the **Activate Schedule** button on the toolbar.
Chapter 4
Requesting Ranking/Tracking Reports

This chapter explains the basics of how to build a Ranking/Tracking report request. The following topics are covered:

- What is Ranking/Tracking?
- Requesting a Ranking/Tracking Report
  - Defining a Report Measurement Period
  - Selecting a Season Year Reporting Measurement Period
  - Defining Measurement Period Exclusions
  - Selecting Averaging and Sorting Options
  - Requesting Program Data
  - Requesting Timeperiod Data
- Scheduling Ranking/Tracking Requests
What is Ranking/Tracking?

The Ranking/Tracking report shows viewing audience estimates for a certain date range including multiple originators and media types.

The Ranking/Tracking product lets you generate reports based on broadcast, syndication, and cable data for both the National People Meter and National Hispanic People Meter samples. You can also combine data from different media types within a single report. The Ranking/Tracking product also gives you the option of creating reports that include program data, timeperiod data, or a combination of both. The requests you create can be used over and over again to report the same type of data but for different dates or originators.

Newly created or existing Ranking/Tracking reports can include all of the available viewing types: Live, Live Plus Same Day (Live+SD), Live Plus Seven Days (Live+7), as well as the Most Current (MC) report option. To help you compare the reported data more easily, Explorer aligns the data side by side in vertical columns. This is known as side-by-side reporting.

The %DIFF statistics can also be included for additional viewing type comparisons. The %DIFF statistics are straight calculations that compare the differences between viewing types based on Household or Demographic Total U.S. AA (000), regardless of the statistics requested within the report specification. These new statistics have been added to the statistics selection screen and can be selected like any other statistic when creating a statistic group. For details, see “Creating Statistic Groups” on page 2-8.

Note  The Most Current report option is not currently compared using a %DIFF statistic.

You can request a Ranking/Tracking report for a specific date range of viewing data. Once you create a request, it must be submitted to the server and processed for the specific dates you select. When the processing is complete, you can download the data to your PC and view or print the final report.

You can automate this process by building a schedule of requests that are applied to the most current data on a regular basis. This type of request is referred to as an auto Ranking/Tracking request.

You can also request a special analysis Ranking/Tracking report. A special analysis report includes data for which you do not have unlimited access rights. If you select a measurement period, originator, or viewing source group, and you do not have unlimited access to all items in the group, you are billed for each individual report you generate using this request.

The system turns on the Special Analysis check box, in the upper right corner of the request window, to indicate that you are requesting a special analysis report. At the time you submit the request, or place it on hold, the Report Cost window displays to show you the breakdown in costs for running that report. You cannot place a special analysis request on a schedule.
Requesting a Ranking/Tracking Report

Galaxy Explorer includes templates for building program, timeperiod, and combination requests.

You can use a template to create your Ranking/Tracking reports or you can design your own. The Ranking/Tracking product comes with templates for building a variety of program and timeperiod reports, as well as reports that include combined program and timeperiod information.

To request a Ranking/Tracking report:

1. Click the **Ranking/Tracking** button on the toolbar.
2. In the **Request Name** field, assign the request a name and enter the title you want to appear at the top of your report.
3. From the **Template Name** drop-down list, select the template you want to use and answer Yes to the message that appears. The format settings for the template you selected appear on the Format tab.
   
   **Tip** To see how the report will look, from the Request menu, select Template Maintenance.

4. On the **Groups** tab, select the demographics and statistics groups you want to use and the program and/or timeperiod information you want to include.

   **Note** The required items, based on the template you selected, appear in bold.

   Select the demographic group you want to report on.

   If requesting a program report, complete this section. See “Requesting Program Data” on page 4-9.

   If requesting a timeperiod report, complete this section. See “Requesting Timeperiod Data” on page 4-11.

   If requesting a combined program and timeperiod report, complete both sections.

5. Click the **Meas Per** tab and select a measurement period for the report. For details, see “Defining a Report Measurement Period” on page 4-4.

6. To save the request, click the **Save** button on the toolbar.

7. To submit the request for processing, click the **Submit** button on the toolbar.

   **Note** If you want to wait and submit your requests when it is more convenient to connect to the server, click the Hold for Submission button on the toolbar.
Requesting a Ranking/Tracking Report

Defining a Report Measurement Period

A measurement period is a specific date range for which you request ratings data. You can also define relative periods, such as current working month or current complete quarter.

To define a report measurement period:

1. On the Ranking/Tracking request window, click the Meas Per tab.
2. From the Calendar drop-down list, select the type of calendar you want to use. The displayed measurement period defaults to the current month for the selected calendar.
   
   Note If you do not want to use any of the standard Nielsen Media Research calendars, you can select Custom and choose your own start and end dates.

3. Select the default measurement period. Then right-click and select Properties.

4. Select the dates you want included in the measurement period.

5. When you have completed the measurement period details, click OK.

6. In the Increments area, select the incremental totals you want to report within the measurement period. Your options are daily (D), weekly (W), monthly (M), quarterly (Q), or the total measurement period (Tot).

7. To omit certain dates, days, or times within the period, define an exclusion. For details, see “Defining Measurement Period Exclusions” on page 4-6.

8. To select another measurement period, right-click, select Add Measurement Period and repeat steps 2 - 7.

9. The measurement periods are reported in the order they appear in the list box. To arrange the order, use the drag and drop feature.
Requesting a Ranking/Tracking Report

Selecting a Season Year Reporting Measurement Period

You can select season-to-date data for a specific season, from the season premiere of the program through the latest available date within the season. Note that the season premiere may or may not correspond to the designated season start date.

When requesting program data, note the following rules:

- You can only use one calendar type per request.
- If you select the Season To Date or Quarter To Date options, you can add a new row and select an additional season or quarter. You cannot, however, create a new custom season or quarter.
- If you select the Premiere To Date option, you can select a custom end date.

To select a To Date measurement period:

1. On the request window, click on the Meas Per tab.
2. From the Calendar drop-down list, select the type of calendar you want to use. The displayed measurement period defaults to the current period for the selected calendar.
3. Select one or more of the Season Year Reporting options.

![Selecting Season Year Reporting Measurement Period](image)

**Note** You cannot select other Season Year Reporting options when you select Premiere To Date.

4. If you want the currently displayed measurement period, go to step 8.
5. To change the date range, right-click the default measurement period and select Properties... from the pop-up menu. The Measurement Period - Detail window opens.
6. In the list box, select Seasons or Quarters and do one of the following.

<table>
<thead>
<tr>
<th>To select...</th>
<th>Do This:</th>
</tr>
</thead>
<tbody>
<tr>
<td>A different season or quarter</td>
<td>Select the season or quarter. The selected period is highlighted on the calendar.</td>
</tr>
<tr>
<td>A different premiere period</td>
<td>In the calendar, click on the weeks you want to use. The selected dates are highlighted.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip</strong> To select multiple weeks, hold down the Shift key and click on each week or the first and last week in a range.</td>
</tr>
</tbody>
</table>

**Note** If you select Season To Date, only the Seasons option is available in the list box.

7. Click OK. The Measurement Period - Details window closes.
8. Save your selections.
Defining Measurement Period Exclusions

Once you define a measurement period, you can choose to exclude certain portions of that period.

To define measurement period exclusions:
1. On the Ranking/Tracking request window, click the Meas Per tab.
2. Select the measurement period for which you want to define an exclusion.
3. Right-click and select Add Exclusion.
4. Define the period you want to exclude.
   
   **Note**  You cannot exclude all days and all times.

5. When you have completed the exclusion definition, click OK.
6. To define another exclusion, repeat steps 2 - 5.
Selecting Averaging and Sorting Options

Use the Avg Opts tab on the Ranking/Tracking request window to select averaging and sorting options.

When requesting program data, note the following rules:

- The 1/4 hour Levels to Include options are not available with the Strict Daypart and Daypart Over-runs reporting options. Strict daypart is based on program 1/2 hours.

**To select averaging and sorting options:**

1. From the **Ranking/Tracking** window, click the **Avg Opts** tab.
2. In the **Additional Averaging Options** area, indicate if you want to average program data across like days; for example, average across all Mondays.
   
   **Note**  This averaging option is dictated through the daypart group for timeperiod reporting.
3. In the **Levels to Include** area, indicate at what levels you want to report data and the report segments you want to display for each.
   
   **Note**  If you make no selections, the report automatically displays total program averages. Any other selections you make must also be selected on the Format tab.
4. To display the programs in alphabetical order, from the **Sort** area, select **Alphabetical**.
   - or -
   To display the programs by telecast in order of the date and time they aired, select **Chronological**.
5. To include breakouts or specials in your program averages, in the **Combine with Pgm Avg** area, select the appropriate check box.
   
   **Note**  Averaging will only occur if the breakouts and specials have the same program identification as the related program.
6. If desired, select additional reporting options

   Select to report repeats separately from the rest of your program data.
   Select to start season-to-date averaging again at a premiere.

   Select to report separately the viewing of segments of programs that start before and/or end after the daypart.

   Select to substitute episode names for any program names of movies or sports.
   **Note** This option only applies to cable programs.
   Select to include contributing viewing of all programs that air within the daypart, regardless of their start and end times.
7. To have a bottom line average on your Microsoft Excel report for originators, viewing sources, dayparts, summary type codes, detail type codes, or measurement periods, select the appropriate check box.

8. To include a combined report total for each selected bottom line average report option(s), select the **Report Totals** check box.

9. If you use a grid template, depending on the template, one or more of the Grids options are automatically selected. You can also select one or more of the following.

![Grids Options](image)

**Note**  
Up to four hours of data for six networks fit on one printable grid page.
Requesting Program Data

Use the Program section to identify what programs you want to appear on your report. Once a program list is generated for the request, the Program Search Performed check box is turned on.

The system uses the selections you make in the Program section of the request to build a program list for the report. In addition to these selections, you can select program indicators, type code groups, and/or program names groups to further define the programs you want to appear on your report.

Tip  You can build the program list before you submit the request by clicking the Execute Program Search button on the toolbar. When the list displays, you can edit or print the results. You can also save the list as a names group by clicking the right mouse button and selecting Save as Names Group.

When completing the Program section, keep in mind the following rules:

- If you want to request proprietary information, you must select an originator group of which all the members are owned by your originator.
- When requesting a combination of time period and program information, you must select the same daypart group in both the Program and Timeperiod sections.
- Selecting a daypart group limits the programs reported to those with start times that fall within the dayparts included in the daypart group.
- If you select an originator group that includes originators for which you do not have unlimited access rights during any portion of the selected measurement period, the request is considered a special analysis.

To request program data:

1. From the Ranking/Tracking window, click on the Groups tab.
2. From the Originators drop-down list, select the originator group whose programs you want to report on.
3. To report on a specific portion of a day, select a daypart group from the Dayparts drop-down list.
4. To include programs based on certain program indicators, click the Indicators tab.

Checkmarks identify the services for which each indicator is available. To exclude programs based on the indicator, select this check box.

For some indicators, you can enter a specific value. For example, you can enter 30 for Normal Duration to see programs with a normal duration of 30 minutes.

Select an indicator and click Add>>. You can also add an item by double-clicking on it. To add several items click on the first item and, while holding down Shift, click on the last item. Then click Add>>.
5. To include programs based on certain type codes, click the **Type Codes** tab.

   **Note** When you exclude a type code group, all other type code groups of the same category are also excluded.

6. To include a specific program names group, click the **Names** tab.

   **For More Information**

   For more information on requesting program data as well as viewing and editing a program list, search for “program lists” in the online Help.
Requesting a Ranking/Tracking Report

Requesting Timeperiod Data

Use the Timeperiod section to select the viewing source groups and daypart groups you want to appear on your report.

When completing the Timeperiod section, keep in mind the following rules:

- When requesting timeperiod information only, you must select a viewing source group and a daypart group. Plus, both viewing sources and dayparts must appear on the Format tab.
- When requesting a combination of timeperiod and program information, you must select the same daypart group in both the Program and Timeperiod sections.

To request timeperiod data:

1. From the Ranking/Tracking window, select the Groups tab.
2. From the Viewing Sources drop-down list, select the viewing source group that represents the coverage area and viewing source combinations for which you want to report data.
3. From the Dayparts drop-down list, select the daypart group that identifies what portion of the day you want to report on.
Scheduling Ranking/Tracking Requests

You can automate the process of submitting your Ranking/Tracking requests by putting them on a schedule.

Scheduling a request that includes a relative measurement period, lets you generate reports using the same request criteria but for different periods of data. The system generates the reports based on a period relative to the day you select as your frequency. For example, if you schedule a request with a measurement period of current working week and you schedule it to run on Thursday, your reports include all data available for the current week through Thursday.

To schedule Ranking/Tracking requests:

1. Click the **Scheduler** button on the toolbar.
2. Click the **Tracking** tab.
3. Right-click and select **Add Row**.
4. Select the request you want to schedule for processing.
5. Repeat steps 3 and 4 for each request you want to include on the schedule.
6. Click the **Save** button on the toolbar.
7. To place the scheduled request on the server, click the **Activate Schedule** button on the toolbar.

   **Note**  To monitor the processing of your scheduled requests, use the **Submitted Status** tab on the Report Manager window. From this tab, select **Auto Tracking** or **Grids Auto Tracking** from the Type list.

8. To temporarily remove the scheduled request from the server, click the **Deactivate Schedule** button on the toolbar.

   **Note**  To modify a row on the schedule, you must first deactivate it. When you have completed your changes, you can make it active again by selecting the row and clicking the **Activate Schedule** button on the toolbar.
Chapter 5
Working with Explorer Reports

This chapter explains how to download your report data, as well as how to view and print the final report. The following topics are covered:

- An Overview of Reports
- Viewing Report Status
- Downloading Reports
- Viewing and Printing Reports
**An Overview of Reports**

*Once you download your report data, you can print the report or view and edit it using Microsoft Excel.*

When your requests complete processing, you can download the results to your PC. For Overnights and Ranking/Tracking requests, the final report is generated at the time you download.

**How a Request Becomes a Report**

- Requests are processed on the server and the report data is returned to you.
- You download the report results to your PC.
- View, print, or modify reports in Excel.
Viewing Report Status

When your report requests complete processing, and the data is available, they are listed on the Report Manager window as completed.

To view the status of your reports:

1. Click the Report Manager button on the toolbar. The Report Manager window appears.
2. Click the Submitted Status tab.
3. To filter the list of reports, select the report type and status you want to view.
   
   **Tip** Using the Preferences window, you can set up default filter and sort criteria so you don’t have to select it each time you want to view the status of your reports. For details, see “Setting Preferences” on page 8-5.

4. To sort on a specific column, left-click on the column heading. To perform additional sorts, right-click on any of the other column headings.

5. To update the list with the most current status from the server, click the Refresh button on the toolbar.
   
   **Tip** If you are waiting for specific requests to complete processing, you can select the Auto Refresh check box, and the system updates the list box every minute with the latest status.

6. Once you find the reports you are looking for, you can copy the results to your PC by downloading the reports. For details, see “Downloading Reports” on page 5-4.

For More Information

For more information, search for “report status” in the online Help.
Downloading Reports

*Downloading report results to your PC provides you with the flexibility to format, view, and print the completed reports.*

Downloading a report copies the report results from the server to your PC. When you download an Overnights, Ranking/Tracking, or Cable Dailies report, the system copies the report output to your PC as a report file (.xls), a data file (.csv), or both, depending on what you requested.

**Note** If you download Cable Dailies data that was previously downloaded, any associated report files are replaced with the new data. You must, however, regenerate your reports to include the new data.

To download your reports:

1. Click the **Report Manager** button on the toolbar. The Report Manager window appears.
2. Click the **Submitted Status** tab.
3. To filter the list of reports, select the report type and/or status you want to view.
4. To sort on a specific column, left-click on the column heading. To perform additional sorts, right-click on any of the other column headings.
5. To update the list with the most current status from the server, click the **Refresh** button on the toolbar.
   
   **Tip** If you are waiting for specific requests to complete processing, you can select the Auto Refresh check box, and the system updates the list box every minute with the latest status.

   **Tip** To receive e-mail notifications when your report is complete and ready to download, from the Ranking/Tracking window, select the Options tab and enter one or more e-mail addresses in the Email Id field. For more information, see “About E-mail Notification” in the online Help.

6. Select the reports you want to download and click the **Download** button on the toolbar.
   
   **Note** You can only download reports with a status of C (Complete).

   A pop-up window appears stating the amount of time required to download the selected files.
7. Click **OK** on the pop-up window.
   
   The report results are downloaded to your PC. Once the results are on your PC, you are ready to view or print the final report.
Viewing and Printing Reports

From the Downloaded Reports tab, you can view or print your reports using Microsoft Excel.

The Report Manager window lets you select one or more reports and open them in Microsoft Excel. The information you see in Excel varies depending on the criteria you defined on the report request. The system generates an Excel workbook with tabs for each report section, the Boilerplate, and UE/Intabs information.

A Boilerplate section is created for each generated report. This section outlines the criteria you defined on your report request. The system also creates a message section any time the system is unable to process all the requested data. This section explains why the processing could not be completed, for example, you requested viewing sources that were not available for the requested days.

To view your reports:

1. Click the Report Manager button on the toolbar. The Report Manager window appears.
2. Click the Downloaded Reports tab.
3. To filter the list of reports, complete the search criteria based on the set of reports you want to view.

   Tip Using the Preferences window, you can set up default search criteria so you don’t have to select it each time you want to view your downloaded reports. For details, see “Setting Preferences” on page 8-5.

4. To sort on a specific column, left-click on the column heading. To perform additional sorts, right-click on any of the other column headings.
5. Select a report from the list box and click the View button on the toolbar.
The system opens Excel and displays your report. The Boilerplate section appears on top.

**Tip** Once you open a report or file in Excel, you can use any of the Excel functions.

To print your reports:

From the **Downloaded Reports** tab, select the report and click the Print button on the toolbar.
Chapter 6
Working with Lightning Requests

This chapter explains the basics of how to build a Lightning request and then work with the report you produce. The following topics are covered:

- What is Lightning?
  - Grid Report
  - Program Report
  - Ranking Report
  - TimePeriod Report
  - Trending Report
- Creating a Lightning Request
- Using the Lightning Wizard
  - Selecting Demographics
  - Selecting Statistics
  - Selecting Measurement Periods
  - Selecting Dayparts
  - Selecting Originator Information
  - Selecting Program Types and Inclusions
  - Selecting Program Names
  - Selecting Program Details
  - Designating Ranking Information
  - Selecting Coverage Area/Viewing Sources
- Opening an Existing Lightning Request
- Changing the Criteria or Viewing Level of a Lightning Report
- Saving Lightning Reports in Excel
- Deleting an Existing Lightning Request
**What is Lightning?**

*Lightning reports are interactive. You can change report criteria and/or viewing levels and receive automatic report updates with your changes.*

The Lightning wizard product lets you generate online-interactive summary- or telecast-level reports for seasonal, quarterly, and monthly data. You can change the criteria or viewing level of the report and receive online responses.

The following illustration shows how you work with Lightning:

![Diagram of Lightning workflow]

Using Lightning, you can create requests to produce the following reports:

- Grid
- Program
- Ranking
- Timeperiod
- Trending

**Note**  
*While initially reported as Live, live audience estimates are replaced by Live+7 estimates as they become available. Any computations or averages performed across the December 2005 boundary will include both Live and Live+7 data.*
What is Lightning?

Grid Report

The Grid report allows you to create a grid report for a daypart of up to four hours for one day. The report displays the data for the selected day and the premiere-to-date data from the program premiere to the selected day.

Report Detail

- No detail - fixed format layout only

Required Build Criteria

- Define demographics
- Select custom measurement period
- Choose dayparts

Optional Build Criteria

- Choose originator types
- Choose originators

The following is a sample Grid report:
What is Lightning?

Program Report

A Program report allows you to create program reports at various levels of detail. The online report can be sorted and ranked on a number of columns.

**Note** You can indicate in your Program Report whether a specific telecast is a season premiere or premiere. For more details refer to the online Help and select “premiere indicator” from the index.

**Report Detail**

- Measurement Period
- Originator Type
- Type Codes
- Trackage
- Dayparts
- Originators
- Program Names
- Telecast

**Note** Each column detail is individually selectable. You can change the column order by clicking on a detail and dragging it into the desired position on the wizard.

**Required Build Criteria**

- Define demographics
- Select statistics
- Select measurement period
- Choose dayparts

**Optional Build Criteria**

- Choose originator types
- Choose originators
- Choose type codes
- Choose inclusions
- Select program names
- Select program details
The following is a sample Program report:

<table>
<thead>
<tr>
<th>NH SEASON</th>
<th>DATE</th>
<th>ORIGINATOR</th>
<th>ORIGINATOR DRPT</th>
<th>PROGRAM NAME</th>
<th>PROGRAM NAME</th>
<th>THROUGHDAY NAME</th>
<th>PRESS RELEASE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-15 Sep 20</td>
<td>07/31</td>
<td>ABC</td>
<td>ABC</td>
<td>ABC</td>
<td>ABC</td>
<td>NON-ASSIGNED TRAFFIC</td>
<td>ABC NEWS</td>
</tr>
<tr>
<td>1-15 Sep 20</td>
<td>07/31</td>
<td>ABC</td>
<td>ABC</td>
<td>ABC</td>
<td>ABC</td>
<td>NON-ASSIGNED TRAFFIC</td>
<td>ABC NEWS</td>
</tr>
<tr>
<td>1-15 Sep 20</td>
<td>07/31</td>
<td>ABC</td>
<td>ABC</td>
<td>ABC</td>
<td>ABC</td>
<td>NON-ASSIGNED TRAFFIC</td>
<td>ABC NEWS</td>
</tr>
<tr>
<td>1-15 Sep 20</td>
<td>07/31</td>
<td>ABC</td>
<td>ABC</td>
<td>ABC</td>
<td>ABC</td>
<td>NON-ASSIGNED TRAFFIC</td>
<td>ABC NEWS</td>
</tr>
<tr>
<td>1-15 Sep 20</td>
<td>07/31</td>
<td>ABC</td>
<td>ABC</td>
<td>ABC</td>
<td>ABC</td>
<td>NON-ASSIGNED TRAFFIC</td>
<td>ABC NEWS</td>
</tr>
</tbody>
</table>

Getting Started with Galaxy Explorer  Working with Lightning Requests • 6-5
What is Lightning?

Ranking Report

The Ranking report lets you create an NTI or NSS report with up to four demographics for one statistic. Each demographic is displayed with its corresponding ranking. The report is ordered by ranking on the first selected demographic, but can be reordered by program name. Ranking reports are also available for NHI, NHTI, and NHHI.

Report Detail
- No detail - fixed format layout only

Required Build Criteria
- Define demographics
- Select statistics
- Select measurement period
- Choose dayparts

Optional Build Criteria
- Choose originator types
- Choose originators
- Choose type codes
- Choose inclusions
- Select program names

The following is a sample Ranking report:

![Sample Ranking Report](image-url)
What is Lightning?

**TimePeriod Report**

The TimePeriod report allows you to create reports for coverage area and viewing sources. Reports can be created at daypart, hour, half-hour and quarter-hour level.

**Report Detail**

- Daypart
- Hour
- Half-Hour
- Quarter-Hour

**Required Build Criteria**

- Define demographics
- Select statistics
- Select measurement period
- Choose dayparts
- Select coverage area and viewing source

The following is a sample TimePeriod report:
**What is Lightning?**

**Trending Report**

The Trending report lets you create a report for like measurement periods showing the percentage gain or loss for each program from the first measurement period to the second measurement period. Trending reports can be created for AA Proj, AA% and AA SHR statistics only.

**Report Detail**

- Exclude new premieres
- Exclude discontinued programs

**Required Build Criteria**

- Define demographics
- Select statistics
- Select measurement periods
- Choose dayparts

**Optional Build Criteria**

- Choose originator types
- Choose originators
- Choose type codes
- Select program names

The following is a sample Trending report:
Creating a Lightning Request

You can create a Lightning request based on your criteria selections. The Lightning wizard guides you through the procedure.

You use the same procedure to create each of the Lightning requests.

To create a new Lightning request:

1. Click the Lightning toolbar button. The Lightning window opens with the Lightning wizard window on top.
2. Select Create a new report and click Next.
3. From the list of requests that display, do the following:
   
4. Click Next to continue. The next Lightning wizard window displays.
   
   As each window within the wizard displays, you make your selections and click Next to continue. For details, see “Using the Lightning Wizard” on page 6-10.

   Tip You can move the Lightning wizard window to an area on your desktop so you can see the Boilerplate tab. As you select your request options, they are added to the Boilerplate tab.

5. When you have completed making entries, click Finish. Your Lightning report displays. You can work interactively with the report, if desired. For details, see “Changing the Criteria or Viewing Level of a Lightning Report” on page 6-24.

   Note The Lightning toolbar options are enabled when the report displays. You can perform procedures using toolbar buttons. For details, see “Performing Common Procedures” on page 1-8.

6. To save your report request, do the following:
   
   a. Click the Save button. A Lightning Wizard - Optional Information window displays.
   
   b. Enter the name of the report you are saving and click Finish.
Using the Lightning Wizard

When you set up a Lightning report, you are given a series of options to choose from. These options display through a series of wizards that guide you through the report-building process.

Not all wizard windows described in this section are used for every report type you select. Depending on your report type selection, wizard windows display that let you set up information for each of the following types of information.

- Demographics (page 6-12)
- Statistics (page 6-13)
- Measurement Periods (page 6-14)
- Dayparts (page 6-16)
- Originators (page 6-17)
- Program Types (page 6-18)
- Inclusion (page 6-18)
- Program Names (page 6-19)
- Program Details (page 6-20)
- Ranking (page 6-21)
- Coverage Area/Viewing Sources (page 6-22)

The types of information required for your report type are displayed in a list on the wizard. As you move through the selection process, the list indicates where you are in the process. The following is an example of a program report at the Dayparts selection.

The following tips give you some of the basics for proceeding through the wizard windows.

- If you want to change the report type, you must click the Cancel button and begin the procedure again.
- You can go back to change criteria at any time; click the Previous button until you reach the criteria you want to change.
- When you are done entering all the required criteria, the Finish button is enabled. You can then click Finish to process your report, or you can keep entering Next to further define report criteria.
• Report criteria are added to the Boilerplate tab as you select them.
• Once you have processed your report, you can use the right-mouse button and redisplay a specific wizard window to make additional changes. For details, see “Changing the Criteria or Viewing Level of a Lightning Report” on page 6-24.
Using the Lightning Wizard

Selecting Demographics

Demographics are the classification of sample members based on age, sex, or households. When selecting demographics, you determine the age ranges for each of the categories.

By defining different demographic groups, you can have your ratings data calculated for a particular category or categories of the viewing audience. You must select at least one demographic.

To set up a demographic(s):

1. At the demographic window, do the following:

   ![Image of demographic window]

   - Select a Category.
   - Choose a Start Age.
   - Choose an End Age.

2. To include additional demographics, right-click in the Selected area and click Add. Then set up the demographic using the preceding instructions.

3. To insert a demographic between two selected demographics, click the demographic above where the new demographic is to be inserted; then right-click in the Selected area and click Insert.

4. To remove demographics, select the demographic, right-click in the Selected area and click Delete.

5. To duplicate a demographic, click the demographic to be duplicated; then right-click in the Selected area and click Duplicate.

   **Note**  Change the start or end age on a duplicated demographic as each demographic must be unique.

6. When you have selected all the demographics you need, click Next.
Using the Lightning Wizard

Selecting Statistics

You can select as many statistics as you want to appear in your report.

Statistics are the various types of audience estimates you can include in a Galaxy Lightning report, such as coverage area average audience rating (CVG AA%) or average audience projection (AA PROJ). You must select at least one statistic.

Universe estimates (U.E.) and intabs are available only for Program, Time Period, and Ranking reports. You can, however, create U.E.s and intabs to match your Grid and Trending reports by using the same report specifications, but by selecting a Program, Time Period, or Ranking template.

Note that the U.E.s and intabs reported in Lightning are different from those reported in Explorer. Explorer basecounts are reported on a separate worksheet and are based on the measurement periods selected. Lightning basecounts are reported along with other statistics and are based on contributing telecasts for the specified data row.

To select a statistic:

1. To display the ranking wizard, select the Rank check box. After you click Finish, the Ranking information wizard displays and you can select additional ranking information. For details, see “Designating Ranking Information” on page 6-21.
2. Click on each statistic in the order you want it to appear in your report. Use the drop-down box beside each statistic to determine the number of decimal places of precision the statistic displays.

Tip  The default precision is based on the last-used precision setting.

3. To continue, click Next.
Using the Lightning Wizard

Selecting Measurement Periods

You can select a season, quarter or month measurement period. The Custom calendar allows you to define your own measurement period.

You can select season-to-date data for a specific season, from the season premiere of the program through the latest available date within the season. The season premiere may not correspond to the designated season start date.

You can only use one calendar type per request. If you select Season Year Reporting, you can only define one measurement period. Otherwise, you can define up to two measurement periods for this request. You must select at least one measurement period.

To select a Nielsen Media measurement period:

1. At the measurement period window, from the Calendar drop-down list, select the type of calendar you want to use.
2. Double-click Seasons or Quarters to display intervals.
3. Select an interval and double-click or drag it to the Selected area. The interval then displays in the Selected area.

   Note To remove an interval from the Selected area, drag it back, double-click on the interval you are removing, or right-click in the selected area and select Delete.

4. To include season-, premiere, or quarter-to-date averages in your request, select a Season Year Reporting option.
5. From the Increment area, select at least one increment: Seasonal, Quarterly, or Monthly.
6. To continue, click Next.
To change the end date for Year End Reporting:

1. At the Measurement Period window, from the Calendar drop-down list, select a Nielsen Media calendar.
2. Double-click on the Seasons folder to open it.
3. Double-click on a measurement period or drag it to the Selected area.
4. Click the STD/PTD Reporting button.
5. Select the Season To Date check box.
   -or-
   Select the Premiere To Date check box.
6. Select the Edit End Date to check box.
7. Change the end date and click OK.
   -or-
   Click Cancel to return to the Measurement Period window.

To select a custom calendar:

1. At the Measurement Period window, from the Calendar drop-down list, select Custom.

   Note  The custom calendar defaults to the current month and day.

2. From the Month drop-down list, select the month containing the start date.
3. From the Year field, type the year. The calendar changes to reflect your choices.
4. Select the start date and click the Start Date button.
5. From the Month drop-down list, select the month of the end date, if different from the start date.
6. From the Year field, type the year of the end date, if different from the start date.
7. Select the end date and click the End Date button.

   Note  Season Year reporting is not available for Custom Calendar.

8. In the case of a Grid report, you only need to select a single date from the calendar, as it acts as both the start and end date.
9. To continue, click Next.
Using the Lightning Wizard

Selecting Dayparts

A daypart is an interval of time within a day for which you can report audience data. It is defined by days and hours. You can select one or more dayparts from a list of pre-defined dayparts for your report request.

The program(s) that appear on your report will have a start time that is within the timeperiod of the daypart(s) you select here.

To select dayparts:

1. Highlight the dayparts you want to use. You must select at least one. The Selected field indicates how many dayparts have been selected.

2. To continue, click Next.

   -or-

   To process your report, click Finish. Average data is only enabled when the Dayparts window is opened in the Timeperiod template. Average data defaults to across days.

3. To change the average option to Individual days, select the Individual Days button. The selected field indicates how many originators have been selected.
Getting Started with Galaxy Explorer  
Working with Lightning Requests • 6-17

Using the Lightning Wizard

Selecting Originator Information

You can request information on all originators or you can identify specific originators.

This procedure describes how you use the originator sections of the Lightning Wizard.

**To identify originators:**

1. At the originator type window, do the following:

   Choose one or more originator types.  
   - or -  
   Choose none to indicate you want to include all originator types in your report request.

2. To continue, click **Next**. The originators window displays the originators for which you have access rights and are applicable to the type(s) you selected.  
   - or -  
   To process your report, click **Finish**.

3. From the originators window, do the following:

   Choose one or more originators.  
   - or -  
   Choose none to indicate you want to include all originators in your report request.

4. To continue, click **Next**.  
   - or -  
   To process your report, click **Finish**.
Selecting Program Types and Inclusions

You can define your report request to only show programs of a particular type or types.

To identify program types:

1. At the type codes window, do the following:

Choose the summary or details tab to display each list.

Choose one or more program type codes
-OR-
Choose none to indicate you want all program type codes in your report request.

Note Only one type of Program Code can be selected at a time. You cannot display a mixture of summary codes and detail codes. Selecting the Summary tab and choosing none will include all summary codes in your report. Selecting the Detail tab and choosing none will include all detail codes in your report providing you have not selected one or more summary codes from the Summary list.

2. To process your report, click Finish.
-OR-
To continue, click Next. The inclusion window displays.

3. From the inclusion window, use the drop-down lists to define your inclusion criteria.

4. To process your report, click Finish.
-OR-
To continue, click Next.
Using the Lightning Wizard

Selecting Program Names

You can define your request to include specific program names.

To select a program name:

1. At the program names window, click Retrieve. A list of all selections made on the Originators window appears.

   **Note** If you do not select Retrieve, all programs are selected by default.

2. Double-click an originator to display programs or drag the originator node to select all programs for that originator.

3. Select a program in the **Available Programs** area and drag it to the **Selected Programs** area.

   **Tip** To remove a program from the Selected area, drag it back, double-click on the program you are removing, or right-click in the selected area and click Delete.

4. To continue, click Next.
Using the Lightning Wizard

Selecting Program Details

This option lets you add program details to your Lightning report.

**To select program details:**

1. At the **Program Details** window, choose one or more program details to display on your report.
   
   -or-
   
   To indicate that no program details will appear on the report, do not select any program details. The selected field indicates how many program details are selected.

2. To process your report, click **Finish**.
Using the Lightning Wizard

Designating Ranking Information

This is an optional selection that lets you specify how much information you want to be ranked in your report.

To display this option you must check the Rank button on the statistics wizard or use the right-click menu on a created report and select Ranking. For details, see “Selecting Statistics” on page 6-13. Once your report displays, you will be able to change the ranking information. For details, see “Changing the Criteria or Viewing Level of a Lightning Report” on page 6-24.

To rank information:

1. At the last window you are setting up for this request, click Finish. The ranking window displays.
2. At the ranking window, enter the number of rows you want to display. You can enter up to 1000 rows, initially.
3. Highlight one or more statistics on which to rank your information. 
   
   **Note** The first time you run this request, you are restricted to 1000 rows. Afterwards, the number is determined by the actual number of rows within the report.

4. Click Finish to process the report.
Using the Lightning Wizard

Selecting Coverage Area/Viewing Sources

The Coverage Area/Viewing Sources window only displays within the TimePeriod Report.

To select Coverage Area/Viewing Sources:

1. From the Coverage Area window, do the following:

2. To select multiple viewing sources, hold the Shift key down as you click to select each viewing source. Continue to press the Shift key and drag selections to the selected area.

3. To delete a viewing source, right-click in the Selected area and click Delete.

4. To process your report, click Finish.
Opening an Existing Lightning Request

You can open a Lightning request that you previously saved.

You can use these requests to show the same information or to modify the request and show new information.

To open an existing Lightning request:

1. Click the Lightning toolbar button. The Lightning window opens with the Lightning wizard window on top.
2. Select Open an existing report and click Next. The next window opens.
3. Select the desired report request and click Next. The request opens.
4. To process the report without making any changes to the request, click Finish.
   -or-
   To make changes to the request, click Next to change the criteria.
### Changing the Criteria or Viewing Level of a Lightning Report

You can work interactively with your Lightning reports.

Once you display a report, you can change the criteria, viewing level, sort order, and ranking order of the report data.

<table>
<thead>
<tr>
<th>To …</th>
<th>Do this:</th>
</tr>
</thead>
</table>
| Add lower-level data to a Lightning TimePeriod report | 1. On the report, right-click to display the pop-up menu.  
2. Select Drill.  
3. From the secondary drill menu, select the desired level of data.  

**Note** This process may take longer once you get to the lowest level of data. |
| Apply minimums to a Lightning report | 1. On the report, right-click to display the pop-up menu.  
2. Select Apply Minimums. The report updates with the minimums applied.  

**Note** If minimums are not met, the data is not reportable. |
| Change the report criteria | 1. On the report, right-click to display the pop-up menu.  
2. Select Wizard.  
3. From the secondary menu list, select the criteria you want to change.  
4. On the wizard window, select your changes.  
5. You can move through the wizard windows to change more selections by selecting Previous or Next.  
6. When you have made your changes, click Finish. A report is updated with your new criteria. |
| Change the sort order on a Program, TimePeriod or Trending Lightning report | To sort a report in ascending order, click on a column heading.  
-or-  
To change to descending order, click on the column heading again.  
-or-  
To sort on multiple columns, hold down the Ctrl key and click on each column heading on which you want to sort. |
| Add lower-level data to a Program report | 1. On the report, right-click to display the pop-up menu.  
3. Click the check box beside the column to be added.  
4. Click Finish. |
<table>
<thead>
<tr>
<th>To …</th>
<th>Do this:</th>
</tr>
</thead>
</table>
| Change the column order on a Program report | On the request wizard, click on a column name in the available column list and drag it to the desired position in the list. Continue through the wizards to create the report.  
-or-  
1. On the report, right-click to display the pop-up menu.  
3. Click on a column and drag it to the desired position.  
4. Click Finish. |
| Filter data by one or more cells | 1. Click on a cell.  
2. To select additional cells to filter on, hold down the Ctrl key and click on the cell(s) within the same column.  
3. Right-click to display the pop-up menu.  
4. Select Filter. The report displays with the filtered data only.  
5. To filter on multiple columns, you can repeat the process for the additional columns.  
**Note** The filters you select display on the Boilerplate tab.  
6. To redisplay the original report, right-click to display the pop-up menu and click Unfilter. |
| Rank the data and add a ranking column | 1. On the report, right-click to display the pop-up menu.  
2. Select Ranking. The ranking wizard displays with the number of rows and the statistics used in your report.  
3. In the Rows box, enter the number of rows you want ranked.  
4. In the statistics area, select the statistic(s) you would like to rank the data by.  
5. Click Finish. The report redisplay according to your selections.  
6. To unrank the report, click the selected statistic(s), to deselect it, and click Finish. |
Saving Lightning Reports in Excel

Lightning lets you display and work with your reports in your Windows environment, but you can also save your Lightning reports as Excel files.

To save your Lightning report as an Excel file:

1. From the Lightning report window, select Save As from the File menu.
2. From the Select File window, do the following.
3. To save your file, click OK.

![Select File window with instructions]
Deleting an Existing Lightning Request

Use this option to delete any Lightning requests you no longer need.

To delete an existing Lightning request:

1. Click on the Lightning toolbar button. The Lightning window opens with the Lightning wizard window on top.
2. Select Delete an existing report and click Next.
3. Select the request to be deleted and click Finish. An empty report window opens.
4. Close the report window.
Chapter 7
Managing Your Software

This chapter explains the different functions for viewing and updating the Galaxy Explorer information stored on your PC. Galaxy Explorer provides a tool for performing each of the following tasks:

- Changing Your Password
- Viewing General Announcements
- Viewing Reprocessing Information
- Updating Your System
Changing Your Password

When you change your password, you are connected to the Nielsen Media Research server so that the password is recorded on the server, as well as on your PC.

Your first time using the system, enter the password provided by Nielsen Media Research. Once on the system, you can change this password to something you can easily remember.

To change your password:

1. Click the Password Change button on the toolbar. The Password Change window appears.
2. Enter your current user ID and password. For security purposes, your password appears on the window as asterisks.
3. Click OK. The system verifies you entered a valid ID and password.
4. Enter your new password.
5. Click Change. The system verifies the new password by matching it with what you typed in the Verification box. The system then saves your new password.
Viewing General Announcements

The Newsline window is an online bulletin board that displays general announcements and data availability.

Use the Newsline window to view Galaxy Explorer announcements and data availability.

To view Newsline announcements:

- Click the Newsline button on the toolbar. The Newsline window appears with the most recent announcements since you updated your system.

Tip To verify you are seeing the latest messages, you can update your system by clicking the Synchronize button on the toolbar. For details, see “ Updating Your System” on page 7-5.

Note You can also view messages related to Galaxy Explorer by clicking Product Notifications on the National Client Service Center home page.
Viewing Reprocessing Information

The Reprocessing window is an online bulletin board that displays information regarding reprocessed program data. You select search criteria to display a specific set of reprocessed data.

**Note** A footnote displays on both Explorer and Lightning reports indicating whether the report contains Reprocessed or Preliminary data.

**To view reprocessing information:**

1. Click the **Reprocessing** toolbar button. The Reprocessing window displays.
2. Select a service type from the drop-down list. The originators for that service type display in the Originator list box, and the reprocessed data displays in the reprocessing list box.
3. To change samples, from the **Sample** box, choose National or Hispanic. The Originator list box re-displays the originators for the sample you choose.
4. To display data for one originator, select it in the Originator list box.
   **Note** To update the data according to your selections in the Originator list box and/or the date fields, tab to the next field or click in the reprocessing list box.
5. To display data for more than one originator, hold down the Ctrl key and click each additional originator.
6. To view data for a specific date range, enter the start and end dates.
7. Choose how you want to view the data.

The system updates the list to show only those listings that match the selected criteria. Each listing shows if the reprocessed data includes proprietary and/or shared dictionary data changes, as well as viewing estimates changes.
Updating Your System

To successfully process your requests, you must be working with the latest version of the software.

If you attempt to connect to the server and your software is out-of-date, a pop-up window appears informing you that you need to synchronize your software. Before you continue, you should save any work you have in progress. This is because if the update includes application files, the system automatically shuts down when the synchronization is complete, and you must restart Galaxy Explorer.

If you choose not to complete the update, the message redisplay each time you try to connect to the server until you complete the synchronization.

You can update your software before connecting to the server by clicking the Synchronize button on the toolbar.

To update your system:

1. Before you continue, save any work you have in progress in Galaxy Explorer, as well as any other applications.

2. On the message window, click Yes to confirm the synchronization. The system checks to verify you have enough disk space and then updates the files and/or database tables. A status bar displays for each update.

   Note  If you do not respond to this message within a certain amount of time, the system automatically starts the synchronization.

3. When the synchronization is complete, a message appears in the message area stating that the application and/or database is synchronized.

4. If you were required to synchronize application files, the system automatically shuts down, and you must restart Galaxy Explorer.

   Note  If an error occurs during synchronization, the process is canceled. If you get an error due to not enough disk space, clean up your disk space and try again. For most other errors, follow the instructions or contact the Client Support Services Helpline at 1-800-423-4511.
Chapter 8
Additional Features

This chapter explains several features Galaxy Explorer provides to make generating your reports easier. The following topics are covered:

- Exporting Groups and Requests
- Importing Groups and Requests
- Attaching a Macro
- Setting Preferences
Exporting Groups and Requests

When you export a request, you can also export the included groups.

You can copy your groups or requests to a common directory where they can be shared by multiple users. You can also export groups or requests to a diskette so you can import them to another PC.

To export a group or request:

1. Open the appropriate group or request window.
2. Click the Export button on the toolbar.
3. Select the specific group or request you want to export.
4. In the Filename box, enter the drive, directory, and filename to which you want to copy the group or request.
5. Click OK.
Importing Groups and Requests

You can use groups or requests created by other users by importing them to your PC.

Before you can import a group or request, the original owner must export it to a common directory or diskette. Once you import a group or request, you can use it just as you would your own.

To import a group or request:

1. Open the appropriate group or request window.
2. Click the Import button on the toolbar.
3. Click Browse.
4. Select the drive and directory that contains the group or request you want to copy.
5. Select the specific group or request and click OK. The selected group or request appears in the list box.
6. Click OK.
7. If the group or request you imported has the same name as one you already own, a pop-up window appears giving you three options.

<table>
<thead>
<tr>
<th>To…</th>
<th>Choose:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace your group or request with the new one of the same name</td>
<td>Overlay</td>
</tr>
<tr>
<td>Rename the new group or request</td>
<td>Use new name and enter a new name in the box</td>
</tr>
<tr>
<td>Cancel the import of the new group or request</td>
<td>Skip</td>
</tr>
</tbody>
</table>

8. Click OK.
9. If you imported a request that includes a group by the same name as a group you already own, a pop-up window appears giving you four options.

<table>
<thead>
<tr>
<th>To…</th>
<th>Choose:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace your group with the new group of the same name</td>
<td>Overlay</td>
</tr>
<tr>
<td>Rename the new group</td>
<td>Use new name and enter a new name in the box</td>
</tr>
<tr>
<td>Cancel the import of the new request</td>
<td>Skip request</td>
</tr>
<tr>
<td>Use your existing group instead of the new group by the same name</td>
<td>Use existing group</td>
</tr>
</tbody>
</table>

10. Click OK. The request is added to your list of available requests.
Attaching a Macro

You can attach a macro, which you create in Microsoft Excel, that automatically formats your report results.

When you attach a macro to a request, the system automatically applies the appropriate formatting when you download the report results. For details on creating macros, refer to your Microsoft Excel documentation.

To attach a macro to your request:

1. From the Overnights Request or Ranking/Tracking Request window, click on the Options tab and then click the Attach Macro button on the toolbar.
2. Select the drive and directory where the macro is located.
3. In the Macro Name box, enter the name of the macro you want to attach.
4. Click OK.

To detach a macro:

On the Attach Macro window, clear all three text boxes and click OK.
Setting Preferences

You can use the Preferences window to set a default login user ID, program list sort levels, and Report Manager filters.

Using the Preferences window, you can select default settings for certain features of your Galaxy Explorer software.

Setting a Default User ID
You can set up your user ID to default so you do not have to retype it each time you log in.

To set a default user ID:
1. Click the Preferences button on the toolbar.
2. Click the General tab.
3. In the Default User Login ID box, enter your Galaxy Explorer user ID.
4. Click OK.

Setting Program List Sort Levels
You can set the levels of program details you want to see when viewing your program search results. The sort levels you select do not affect how the program information appears on your reports.

To set program list sort levels:
1. Click the Preferences button on the toolbar.
2. Click the Program Display Sort Levels tab.
3. From the Available list box, select the levels of detail you want to see and click Add>>.
   
   Note To remove selected items, select the items and click <<Remove.

4. The detail levels display in the order they appear in the list box. To arrange the order, use the drag and drop feature.
5. Click OK.
Setting Preferences …

Setting Report Manager Filters
You can set the filters and sort order you want to use when viewing submitted or downloaded reports on the Report Manager window.

To set filters for the Submitted Status tab:
1. Click the Preferences button on the toolbar.
2. Select the Report Manager tab.
3. To limit the displayed requests to a specific type, select the type from the Request Type list box.
4. To limit the displayed requests to those with a specific status, select the status from the Request Status list box.
5. To set a default sort order:
   a. Click the Sort Order button.
   b. Select the sort levels you want to use and click Add>>.
   c. If you want to sort in ascending order for a specific item, select the Ascending check box.
   d. The sort levels are applied in the order they appear in the list box. To arrange the order, use the drag and drop feature.
6. Click OK.

To set filters for the Downloaded Reports tab:
1. Click the Preferences button on the toolbar.
2. Select the Report Manager tab.
3. To limit the displayed reports to those with a specific result type, select the type from the Result Type group box.
4. To limit the displayed requests to a specific request type, select the type from the Request Type list box.
5. To set a default sort order:
   a. Click the Sort Order button.
   b. Select the sort levels you want to use and click Add>>.
   c. If you want to sort in ascending order for a specific item, select the Ascending check box.
   d. The sort levels are applied in the order they appear in the list box. To arrange the order, use the drag and drop feature.
6. Click OK.
Glossary

%DIFF LIVE+7/LIVE
A statistic that compares the difference between Live+7 and Live viewing types based on Household or Demographic Total U.S. AA (000).

%DIFF LIVE+7/LIVE+SD
A statistic that compares the difference between Live+7 and Live+SD viewing types based on Household or Demographic Total U.S. AA (000).

%DIFF LIVE+SD/LIVE
A statistic that compares the difference between Live+SD and Live viewing types based on Household or Demographic Total U.S. AA (000).

Access Rights
The rights a user has to see originators’ ratings data on an unlimited basis.

Air Days and Times
The specific days and times an originator is on the air.

Boilerplate
A section included with each report that outlines the criteria defined on the report request.

Bucket
See Viewing Source.

Combo Dayparts
A combination of two or more dayparts within a group that will have ratings data combined and averaged on the report.

Combo Type Codes
A combination of two or more type codes within a group that will have ratings data combined and averaged on the report.

Coverage Area
A specific group of homes that are capable of receiving a particular broadcast signal.
**Dailies Day**
The 3 a.m.-to-3 a.m. local timeperiod for which Nielsen Media Research gathers daily ratings data for overnight reporting.

**Daypart**
An interval of time within a day for which you can report audience data. It is defined by days and hours.

**Demographics**
Classifications of audience characteristics, based on age and sex, for which you can report data. You can also report data for households. Multiple demographics can be combined into groups that are used to define the columns in Galaxy Explorer reports.

**Derived Durations**
Completion of report duration for multisegmented/complex program by summarizing the minutes tuned for all segments summing the rating for.

**Difference Statistic**
The %DIFF statistics are straight calculations that compare the differences between viewing types based on Household or Demographic Total U.S. AA (000), regardless of the statistics requested within the report specification.

**DNA**
(Data Not Available) A code used on the Boilerplate to indicate data is not available or collected for the date you selected.

**Download**
The process of transferring report data from the server to your PC.
Duration (Lightning)

- Reported Duration works as follows:
  - telecast level = actual duration of the telecast
  - trackage level = most common/most current duration
  - program level = most common/most current duration
- Common Duration is not available at the program or trackage level in Lightning.
- Common Duration in Lightning is called Program Common Duration.
- Program Common Duration is available at the telecast level ONLY. You can look at the actual duration at the telecast level and also know what the common duration for the program was.

The following table describes the duration option specifics:

<table>
<thead>
<tr>
<th>Sort Level</th>
<th>Name on Wizard</th>
<th>Report Column Header</th>
<th>Value Reported</th>
</tr>
</thead>
<tbody>
<tr>
<td>Telecast</td>
<td>Reported Duration</td>
<td>Reported Duration</td>
<td>Actual telecast duration</td>
</tr>
<tr>
<td>Trackage</td>
<td>Reported Duration</td>
<td>Reported Duration</td>
<td>Trackage most common duration/Various duration</td>
</tr>
<tr>
<td>Program</td>
<td>Reported Duration</td>
<td>Reported Duration</td>
<td>Program most common duration/Various duration</td>
</tr>
<tr>
<td>Telecast</td>
<td>Program Common Duration</td>
<td>Program Common Duration</td>
<td>Program most common duration/Various duration</td>
</tr>
<tr>
<td>Program</td>
<td>Average Duration</td>
<td>Average Duration</td>
<td>Average Duration</td>
</tr>
<tr>
<td>Trackage</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Telecast</td>
<td>Total Duration</td>
<td>Total Duration</td>
<td>Total Duration</td>
</tr>
</tbody>
</table>

Episode

A specific airing of a telecast for which cable originators can request ratings data.

Episode Title

A label that identifies a specific creative associated with the telecast of a program.

Estimated Median Age

Estimated Median Age is a calculation based on aggregated building block demographic data. This is not a true median age as data is reported based on building block demographic ranges and not by actual age. Estimated Median Age is available for broadcast, cable, and syndication.
Export
A feature that lets you copy your groups or requests to a common directory or diskette so they can be shared by multiple users.

Group
A collection of components that are used as criteria on Galaxy Explorer report requests.

Import
A feature that allows you to use groups or requests created by other users.

Intab Counts
A count of the number of households or persons in the sample providing usable information for a given measurement period.

Limited Coverage Networks
Limited coverage networks consist of a minimum of 15 hours of programming per week with a National coverage greater than or equal to 30%, but less that 70% of US TV households.

Live
Households tuning or Persons viewing a program or time period of a specific station or cable network, including VCR record, at the actual time the show was telecast. Any use of the DVR to time shift content (regardless of how small the delay) will cause that tuning to be excluded from the Live estimates.

Live+7
Households tuning or Persons viewing a program or time period of a specific station or cable network, including VCR record, at the actual time the show was telecast, and any DVR playback tuning/viewing within 7 days (168 hours) to a pre-recorded program or time period that is shifted 'back' to original telecast time.

Live+SD
Households tuning or Persons viewing a program or time period of a specific station or cable network, including VCR record, at the actual time the show was telecast, and any DVR playback tuning/viewing in the same processing day to a pre-recorded program or time period that is shifted 'back' to original telecast time. The processing day is the same collection day used for daily processing; however, this will also include some households that are in different time zones than the market with which they are collected. As a result, data for some homes may be collected at 2:00 a.m. instead of 3:00 a.m. local time.

Macro
A group of Excel formatting commands that you can apply to your report results.
**Minimums**

The lowest estimates reportable based on sample size, or sample size plus viewing (ratings and projections) data.

**Most Current (MC)**

The latest data available, crossing viewing types, if necessary, based on the measurement interval selected. For example, selecting Most Current data for a measurement interval that is incomplete for Live+7 results in an average of the Live+7 and Live+SD data that is available to date. When the data requested includes measurement periods prior to TSV implementation (December 26, 2005), Most Current will include a combination of Live (pre-TSV) data, Live+7, and Live+SD available to date.

**N/A**

(Not Applicable) A code used on the Boilerplate to indicate the selected demographic statistic does not apply to the report section.

**NHPM**

National Hispanic People Meter.

**Nonreport Weeks**

Designated Monday-to-Sunday weeks in which ratings data is not reported in published reports.

**NPM**

National People Meter.

**Originator**

Any entity responsible for originating programs.

**Overnights**

The Galaxy Explorer product that lets you generate reports based on current available data for broadcast and cable originators, as well as weekly data for syndication originators.

**Precision**

The mathematical rounding option for statistics, for example, tenths or hundredths.

**Prime Portions**

A combination of the prime time components of a program that crosses into or out of prime time.

**Program**

A title that identifies a particular creative production or group of productions that represents how it will be promoted.
**Program Section**
A section within a Galaxy Explorer report that lists ratings data for specific programs, as opposed to specific time periods or viewing sources.

**Projections**
Audiences, expressed in terms of households or persons, derived by multiplying a rating by the appropriate universe estimate.

**Ranking/Tracking**
The Galaxy Explorer product that lets you generate reports based on broadcast, syndication, and cable data for both the National People Meter and National Hispanic People Meter samples.

**Ratings**
Estimated number of viewers tuned to a program or time period, expressed as a percentage of the universe. For details on statistics, see the *National Reference Supplement*.

Rating\% = Audience Projection ÷ Universe Estimate

**Refresh**
The process of connecting to the server to update displayed information so it reflects the current status on the server.

**Report Request**
A user-created specification that defines the criteria used to generate a Galaxy Explorer report.

**Report Type**
The type of Galaxy Explorer report, for example, Overnights, or Ranking/Tracking.

**Reprocessing**
Any processing of lineups that occurs after initial Dailies processing has been completed.

**Request Name**
A name you assign to a Galaxy Explorer report request during the request definition process. The request name identifies the set of specifications used to generate a report and should not be confused with the report title, which identifies the completed report. You can create multiple reports from a single request.

**Rerun Data**
A Dailies day of program and time period data that is reprocessed.

**Sample**
A subset of Nielsen Media Research-metered households selected to represent the universe.
**Schedule**
A group of requests that are processed at user-defined intervals.

**Season to Date**
A program average audience for a specific season, from the season premiere of the program through the latest available date within the season. Note that the season premiere may not correspond to the designated season start date.

**Share**
A percentage of households using television (HUT) that are tuned to a particular program or station in a specified area at a specified time. For details on statistics, see the National Reference Supplement.

\[
\text{Share} = \frac{\text{Program or Timeperiod Audience}}{\text{Households Using Television}}
\]

**Side-by-Side Reporting**
The reporting of any two or all three viewing types or Most Current data in vertical columns, aligned side by side, in order to perform effortless comparisons of time-shifted viewing data. Side-by-side reports are available within Overnights or Ranking & Tracking Reports.

**Special Analysis**
Requesting data for which you have not purchased unlimited access. You will be billed for special analysis reports.

**Start Time (Lightning)**
- Start time is called Telecast Start Time and is only available at the telecast level. The term Telecast Start Time appears in the wizard only. All data is reported with a label of Start Time.
- Common Start Time is a selection at program, trackage, and telecast levels and includes the common start time for reported level. When reported at telecast level, it reports the program common start time. This way you can get the telecast start time and the common start time for the program in the same report for comparison.

The following table describes the start time option specifics:

<table>
<thead>
<tr>
<th>Sort Level</th>
<th>Name on Wizard</th>
<th>Report Column Header</th>
<th>Value Reported*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Telecast</td>
<td>Telecast Start Time</td>
<td>Start Time</td>
<td>Actual telecast start time</td>
</tr>
<tr>
<td>Telecast</td>
<td>Common Start Time</td>
<td>Common Start Time</td>
<td>Program most common start time/variables start time</td>
</tr>
<tr>
<td>Trackage</td>
<td>Common Start Time</td>
<td>Common Start Time</td>
<td>Trackage most common start time/variables start time</td>
</tr>
</tbody>
</table>
Statistics

The various types of calculations that can be included in a Galaxy Explorer report, such as average audience percentage (AA%) or share percentage (SHR%). For detailed descriptions of the different statistics, see the National Reference Supplement.

Status

A description of the current processing state of a report request.

Submit

The method by which report requests are sent to the server for processing.

Telecast

A program airing on a specific day, date, and time.

Trackage

A label assigned to a group of telecasts of a particular program that represents the way these telecasts are sold. Allows for differentiation of multiple telecasts of a program within a day or week.

TSV

Time-shifted Viewing

Universe

Estimates of television households or persons that are able to receive programming.

Viewing Source

A measure of a category of viewing within the total U.S. or the coverage area of the cable originator being measured. Viewing source data is calculated for households only.

Viewing Types

The three types of data (Live, Live+7, and Live+SD) available for reporting.

<table>
<thead>
<tr>
<th>Sort Level</th>
<th>Name on Wizard</th>
<th>Report Column Header</th>
<th>Value Reported*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program</td>
<td>Common Start Time</td>
<td>Common Start Time</td>
<td>Program most common start time/ various start time</td>
</tr>
<tr>
<td>Other</td>
<td>Not Available</td>
<td>Not Available</td>
<td></td>
</tr>
</tbody>
</table>
**Weeks Aired**

A new selection has been added to the list of Explorer Program Detail options on the Report Request window, Weeks Aired. This option indicates the number of weeks within a measurement period that a program aired.

For example, if a program airs five days in one week, but does not air again in the measurement period, the number of weeks is one. If a program airs once per week for five weeks, the weeks aired is five.

Weeks aired is always based on a Monday-Sunday week. This is maintained even if you are using a custom calendar. For example, if you define a nine-day measurement period of Wednesday through Thursday, Wednesday through Sunday counts as one week, and Monday through Thursday counts as a second week.
Symbols

%DIFF LIVE+7/LIVE  2-8, 3-2, 4-2
%DIFF LIVE+7/LIVE+SD  2-8, 3-2, 4-2
%DIFF LIVE+SD/LIVE  2-8, 3-2, 4-2

A
activating schedules
   Overnights 3-10
   Ranking/Tracking 4-12
attaching macros 8-4
auto Overnights 3-2, 3-10
auto Tracking 4-2, 4-12
availability of data 7-3
averaging options, selecting 3-5

B
boilerplate 5-5
buckets See viewing source groups 2-10
bulletin boards, Newsline 7-3

C
closing 1-8
criterion groups See groups 2-2
copying 1-8
coverage area
   Lightning requests 6-22
criteria groups See groups 2-2
customer service vii

D
data availability 7-3
database
   updating 7-5
daypart groups 2-3
dayparts, Lightning requests 6-16
deactivating schedules
   Overnights 3-10
   Ranking/Tracking 4-12
deleting 1-9
   Lightning requests 6-27
demographic groups 2-5
demographics
   Lightning requests 6-12
detaching macros 8-4
downloading reports 5-4
drag and drop 1-9

E
Excel 5-5, 8-4
exclusions 4-6
exiting Galaxy Explorer 1-5
exporting
groups 8-2
report requests 8-2

F
filtering
downloaded reports 5-4, 5-5
   Lightning reports 6-25
preferences 8-6
   submitted reports 5-3
formatting reports 8-4

G
Grid report 6-3
groups 2-2
daypart 2-3
demographic 2-5
exporting 8-2
importing 8-3
originator 2-6
program names 2-7
statistic 2-8
type code 2-9
viewing source 2-10

H
hardware requirements 1-4
Help
   accessing 1-11
   buttons 1-12
   context-sensitive 1-11
   parts of the window 1-10
   searching for a topic 1-11
   using 1-10
Helpline vii
holding requests
   Overnights 3-3
   Ranking/Tracking 4-3

I
importing
groups 8-3
report requests 8-3
inclusions, Lightning requests 6-18
increments, reporting
   Overnights 3-4
Ranking/Tracking 4-4

L

Lightning
- Live+7 estimates 1-2
- overview 6-2
- working with 6-1

Lightning reports
- applying minimums 6-24
- changing criteria 6-24
- filtering 6-25
- Grid 6-3
- Program 6-4
- Ranking 6-6
- ranking 6-25
- sorting 6-24
- TimePeriod 6-7
- Trending 6-8
- unfiltering 6-25
- viewing level 6-24

Lightning requests
- coverage area 6-22
- creating 6-9
- dayparts 6-16
- deleting 6-27
- demographics 6-12
- inclusions 6-18
- measurement periods 6-14
- opening 6-21
- originators 6-17
- program details 6-20
- program names 6-19
- program types 6-18
- ranking 6-21
- saving reports in Excel 6-26
- statistics 6-13
- viewing sources 6-22
- wizards 6-10

Live 1-2, 1-3, 2-8, 3-2, 4-2
Live+7 1-2, 1-3, 2-8, 3-2, 4-2
Live+SD 1-2, 1-3, 2-8, 3-2, 4-2

logging in to Galaxy Explorer 1-5

M

macros
- attaching 8-4
- detaching 8-4
- main window 1-6

measurement periods
- defining 4-4
- exclusions 4-6
- increments 4-4

Lightning requests 6-14
- relative periods 4-4
- season year 4-5
- menus 1-9
- minimums, Lightning reports 6-24
- Most Current (MC) 1-2, 1-3, 4-2

N

networks, See originator groups 2-6

Newsline 7-3

O

online bulletin board, reprocessing information 7-4
online Help, see Help 1-10
opening 1-8
originator groups 2-6
originators, Lightning requests 6-17

Overnight requests
- auto 3-2
- creating 3-3
- overview 3-2
- program data 3-7
- program indicators, selecting 3-7
- program names, selecting 3-8
- scheduling 3-10
- templates, selecting 3-3
- timeperiod data 3-9
- type codes, selecting 3-8
- viewing source data 3-9
- overview, system 1-2

P

password, changing 7-2
percent difference 1-2, 2-8
pop-up 1-9
pop-up menus 1-9
precisions 2-8
preferences
- program lists 8-5
- report manager 8-6
- user ID 8-5
printing reports 5-6
processing, status 5-3
product support vii
production announcements 7-3
program data
- Overnights 3-7
- Ranking/Tracking 4-9
program details, Lightning requests 6-20
program indicators, selecting
- Overnights 3-7
- Ranking/Tracking 4-9
Program lists
  viewing 4-9
program lists
  preferences 8-5
  save as names group 4-9
program names groups
  creating 2-7
  selecting 3-8, 4-10
program names, Lightning requests 6-19
Program report 6-4
program names groups
  creating 2-7
  selecting 3-8, 4-10
program names, Lightning requests 6-19
  saving 1-8
  saving reports in Excel 6-26
  scheduling requests
    modifying 3-10, 4-12
    Overnights 3-10
    Ranking/Tracking 4-12
season premieres 4-5
season-to-date
  Lightning requests 6-14
  selecting 4-5
  selecting items 1-9
side-by-side reporting 1-2, 3-2
software
  requirements 1-4
  updating 7-5
sorting
  downloaded reports 5-4, 5-5
  Lightning requests 6-24
  preferences 8-6
  program lists 8-5
  submitted reports 5-3
  sorting options, selecting 3-5
special analysis 4-2
statistic groups
  creating 2-8
  selecting 3-3, 4-3
statistics, Lightning requests 6-13
status, reports 5-3
submitting requests
  Overnights 3-3
  Ranking/Tracking 4-3
support vii
synchronize 7-5
system overview 1-2

to date statistics viewing 1-2, 2-8, 3-2
status, viewing 5-3
viewing 5-5
reprocessing, viewing information 7-4
right mouse, using 1-9

S
  saving 1-8
  saving reports in Excel 6-26
  scheduling requests
    modifying 3-10, 4-12
    Overnights 3-10
    Ranking/Tracking 4-12
season premieres 4-5
season-to-date
  Lightning requests 6-14
  selecting 4-5
  selecting items 1-9
side-by-side reporting 1-2, 3-2
software
  requirements 1-4
  updating 7-5
sorting
  downloaded reports 5-4, 5-5
  Lightning requests 6-24
  preferences 8-6
  program lists 8-5
  submitted reports 5-3
  sorting options, selecting 3-5
special analysis 4-2
statistic groups
  creating 2-8
  selecting 3-3, 4-3
statistics, Lightning requests 6-13
status, reports 5-3
submitting requests
  Overnights 3-3
  Ranking/Tracking 4-3
support vii
synchronize 7-5
system overview 1-2

to date statistics viewing 1-2, 2-8, 3-2
status, viewing 5-3
viewing 5-5
reprocessing, viewing information 7-4
right mouse, using 1-9

R
  ranking
    Lightning reports 6-25
    Lightning requests 6-21
Ranking report 6-6
ranking/tracking reports
  season-to-date options 4-5
Ranking/Tracking requests
  auto 4-2
  creating 4-3
  measurement period exclusions 4-6
  measurement periods 4-4
  overview 4-2
  program data 4-9
  program indicators, selecting 4-9
  program names, selecting 4-10
  scheduling 4-12
  special analysis 4-2
  templates, selecting 4-3
  time period data 4-11
  type codes, selecting 4-10
  viewing source data 4-11
relative periods 4-4
removing 1-9
report cost 4-2
report manager, preferences 8-6
report requests
  exporting 8-2
  holding 3-3, 4-3
  importing 8-3
  Lightning 6-9
  Overnights 3-2
  Ranking/Tracking 4-2
  scheduling 3-10, 4-12
  submitting 3-3, 4-3
reports
  boilerplate 5-5
  downloading 5-4
  formatting 8-4
  overview 5-2
  printing 5-6
Tracking requests See Ranking/Tracking requests 4-2
Trending report 6-8
type code groups
  creating 2-9
  selecting 3-8, 4-10

U
unfiltering, Lightning reports 6-25
updating your system 7-5
user ID, default 8-5

V
viewing level, Lightning reports 6-24
viewing reports 5-5
viewing source groups
  creating 2-10
  selecting 3-9, 4-11
viewing sources
  Lightning requests 6-22
viewing types 1-2, 2-8, 3-2

W
windows
  closing 1-8
  opening 1-8
  parts of 1-7
  removing 1-9
wizards
  Lightning 6-2
  overview 1-3
  using 6-10